
Cinelerra-GG (Version Infinity)  Release Notes for 10/01/2020-10/31/2020 for builds

Special thanks to Pierre/IgorB for testing and help with great suggestions for improving Tile Mixers.
A lesson in Projector usage with labels and the new GoTo menu has been done by Ugin (Preobraz).

1. Usability Improvements:
   Transitions if disabled will no longer show on expanded tracks or be draggable (expansion is done in
       the patchbay). This was an email request from IgorBeg.
    Camera/Projector autorange icons improved (as provided by Igor Beg in BT #511).
    New Timeblur plugin was created which blurs a certain number of frames together.
    Histogram plugin Frames feature added last month did not meet the user’s specifications so has now
       been modified with a button to “Sum frames” instead to provide a better result.
    Drag Select and Deselect edits on the timeline (BT #494).
    Added Deselect Edits to MMB on the track to unselect edits within the insert pointer area or
       selection area (fary54 within BT #494).
    Spanish translations updated by RafaMar.
    In the Labels folder of the Resources window, a Double Click on a label will move the cursor to that
       label on the timeline, thus avoiding have to use the pulldown option of Go To (fary54 BT #518).
    Some changes in the Window pulldown of Split X / Split Y panes include:
       - The separator lines have been visibly enhanced to make them stand out a little more without
          making them overwhelming (quintao BT #525).
       - Guards have been added to the code in some areas of Split X/Y code to prevent odd behavior.
       - Draw of the panes has had a bug fixed and speedup added, in particular in the case of a redraw.
    Gang mode changes include:
      - Gang flags in the patchbay specifically when in Gang Channels or Gang Media modes will
        operate as set in the Master Track.  For example, if when in Gang Channels mode, you turn off
       “Play track” on the visible audio track, none of the associated channels (i.e. the other stereo or
        other 5 channels will play).  And if in Gang Media mode, if you turn on “Play track” for the
        Master Track, all associated video and audio tracks will play unless you turned off “Play track” for
          some of the associated audio/video slave tracks which will not play (email discussion started by
         Oon-Ee Ng). There is still some work to do here yet and to document.
     - A bug was found while working on Gang Modes where the Master Track was set incorrectly.
     - The gang flag was originally stored in the EDL session but is now moved in order to maintain
       correct rendering.  This means that for any existing project, the gang mode will be set to 1 initially
       but then when resaved in the user preference mode, will be right the next time loaded.
    Proxy changes include:
     - Added 1 (1:1) as an option for proxying because by lowering the bitrate, cpu usage can be as much
       as 4 times lower without having to be concerned with scaling (quintao in BT #516).
     - Revised the menu layout based on user feedback (from several users per BT #516).
   Tile Mixers has been improved so that you can designate a rectangle area where you want the
       mixers to be tiled.  In addition this location of the mixers will saved when you “Save layout” under
       the Window pulldown (IgorBeg/Pierre BT #531).
2. Bugs/Issued Fixed:
   Audio Transitions when On not checked still was on  - now fixed.
   Plugin Server problem when missing for Transitions (Andrew dmp).
   Another vicon render failure was determined to be the cause of a crash that has now been fixed (BT
     #524 by Pierre).
   If the program is stopped while a Render is running, for example a Transcode, there was a crash but



     this has now been guarded against (BT #524 by Pierre).
   Transitions between certain edit conditions is now more correctly handled.
   Record Gui “Video Mtr” button disable will now result in the menu being taken down (Fary54 BT
     #519).
   Updated shortcuts.html file.
   The SVG via Inkscape plugin was no longer honoring the alpha transparency channel due to changes 
     in the Inkscape program.  This has been fixed but if more changes to Inkscape are made, it could
     break again (Armando reported in the forum).
   Updated ffmpeg mpegtsenc bluray patch to get more in synch.
   Tweak asset equivalent for batchrender warn which was causing false alarms.
   Removed redundant ffmpeg leak fix (which was patch 4 as Andrew told us).
   Fixed “Resize Track” menu for assets in Resources window and on the timeline track  to work with
     proxy .  Also added a Reset button to easily revert to the original size, retained the Scale values
     when resized, and made the menu a little wider (IgorBeg BT#530).
   Draw vicon mode in the Resources window for “Src Target” was inadvertently not working but has
     now been fixed (IgorBeg BT#528).
   Resize bug for Filelist type assets, such as png, has been fixed.
   Patch provided to fix compilation when “with-commercial” is used (mehw BT #532).  

Cinelerra-GG (Version Infinity)  Release Notes for 09/01/2020-09/30/2020 for builds

The Bug tracker has reached number 500 in tickets consisting of bugs and requests.
Improvements to the Manual are ongoing with Andrea creating an Advanced Editing chapter and 
MatN very detailed review.  Meanwhile, Andrew has been stress testing the code.

1.  Motion plugin major improvements contributed by Georgy (SGE BT #509) and with his updated  
      documentation added to the Manual.
2.   MotionCV and MotionHV will no longer get built (but code still there).  With Georgy’s better
         Motion plugin, it is preferable to not confuse the situation with multiple choices that might have
         issues anyway.
3.  Because currently existing downloadable 4K webm files when loaded into Cinelerra were no longer
        seekable, we backed down the dav1d library from 7.1 to 5.1.  Unfortunately it took some time to
        discover this as it is not a widely used format in CinGG.
4. Usability Improvements:
    Transitions are now playing much faster as using Cache has been added as a default.  You might see
       a slight hesitation at the beginning of a transition when memory is being loaded then quite often it 
       will play at full speed (Houku BT #495).  There is a Settings→Preference for this called “Cache
       Transitions” and it is enabled by default.  This may be eliminated in the future if there are no
       problems with the caching because everyone will want this speed up.
    Drag Transitions is available to increase/decrease the length and works similar to dragging a
       plugin (Houku BT #495).
    Reverse playback now also uses Cache so that it is faster (Andrew note of slow reverse play).
    14 revised or new FFmpeg formats for rendering have been generated & checked (Andrew).
    Russian translations in ru.po updated by Andrew.
    Spanish translations in es.po updated once again by RafaMar.
    The Aspect height has been increased in size from 10000 to 32767 (related to Shipman BT# 505).
    Menu and tooltip for Undo reads “z or Ctrl-z” now to make it clear as recommended in email.
    Improved SUV patchbay and expand pngs provided by IgorBeg.



    Histogram plugin modifications include:
      - capability to calculate a multiple frame average (a user request driven by need)
      - slider bar Linear to Log with 50% being the default; originally was Log
      - the “average” is now used for each bin / values
      - code cleanup for better readability
5. Bugs/Issues fixed:
    Fixed “Clear Keyframes” which in some cases did not delete the right keyframes (IgorB, Andrea,
       RafaMar BT #501) and create the correct intervals.
    Tweak keyframe popup speed undo.
    Added id-s for keyframes and labels (similar to what had been done for plugins awhile back).
    Fix background rendering to have a “in process” state before actually complete (Andrew BT #497).
    Edge gui fix in the Automation code.
    Dual Monitor mode fix (MatN BT# 502).
    Layout Viewer screen was raised when others weren’t, changed to be the same (MatN review notes).
    Fixed Settings→Preferences, Appearance tab problem with line through Flags/Warnings (IgorBeg).
    Fixed cache aging bug and some cache lock tweaks.
    Modified to push Preferences changes all the way to the render engine; they were not getting there
      before in some cases.
    General code cleanup; for example moved code of location where the background color was set.
    Fixed problem if run out of memory where Cin exits instead of crashes (Andrew-R email report).
    32-bit shared memory fix (Andrew email with dump).
    Undo hide plugin fix (Andrew reported).
    Fixed a problem that occurred if performing a delete while the Render Engine is running.
    Booby fix if running Preferences at the same time as the FFmpeg button first/last is being pressed.
    Alpha is being set to 1 for background color always now – just a missing thing.
    Modified Render Farm to turn off “linger” and Render Farm usage will no longer send messages it
       does not know how to handle.
    Corrected SEGV discovery on load  project when in Create Resources Only mode (Pierre BT #510)
       which was a result of using the wrong copy.
    Original Move tracks up/down along with its shortcut is now back.  Roll tracks up/down has its own
       new shortcut along with its own distinct functionality.

Cinelerra-GG (Version Infinity)  Release Notes for 08/01/2020-08/31/2020 for builds

Special thanks to Andrew, Andrea, Houku, IgorBeg, and RafaMar for testing this month, 
especially of the speed fixes and Auto Bumps as Phyllis was unable to do so.

Release contains a known bug with a workaround.  Clear Keyframes in some cases does not delete 
the right keyframes. The verified workaround is to turn on/off "keyframes follow edits” when this error 
could surface.  It will be fixed as soon as possible and will be correct in next month’s release.

1. Bump float Autos feature has been added which provides a good solution for adding speed to a
    selection, like an edit, as well as some nice useful applications to the camera, projector, etc. 
   Temporary document/explanation is at:  https://cinelerra-gg.org/download/testing/bump_autos.pdf . 
   A new “Create Keyframes”option for a selection area under the Keyframes pulldown was added.
2. Upgraded operating system distros on the build computers.

https://cinelerra-gg.org/download/testing/bump_autos.pdf


3. Changed behavior:
    Shortcut for Undo is “z” as originally + Ctrl-z so that new users are less confused.  Because Ctrl-z
       was already in use with the middle mouse button on a track for “Cut Pack”, that was changed to
       Ctrl-Alt-z (video - Top 8 open source video editor – by Nice Micro).
    Shortcut for Save is “s” as originally + Ctrl-s so that new users are less confused.  Because Ctrl-s
       was already in use under the Settings pulldow for Save settings now, that was changed to Ctrl-
       Shift-S (forum - Ideas for UI Modifications (Improvements?) - note by Tupper).
4. Usability Improvements:
    Language preference is now available in the pulldown Settings→Preferences, Appearance tab on
      the left hand side to make it easy to have CinGG always start in the user’s preferred language (BT
      #113 by MatN and Gerd via mailing list).  Note that the only current choices are the ones that I am
      quite sure are actually being used.  You can still set the environment variable LANGUAGE for
      other translations like Slovenia, Chinese, Portuguese, etc and if requested, we will add another
      possible translation in but they have not been updated in a long time and are only done via an
      automatic translator with no personal corrections done.
    Ydiff was upgraded to work for rgb/yuv and 16 bit depth.  This was done in order to better analyze
       the problem in the forum of “Loss of detail” by dejay.
    Prores format for rendering was modified to use a default of “profile=3” for High Quality instead of
       the original “profile=2”.  It will take longer to render and produce a larger file but the quality
       difference is certainly better with a ydiff difference of only 1.7 versus 7.7.  This is again in
       reference to the forum “Loss of detail” by dejay.
    Default settings for new configuration setup in $HOME/.bcast5 have been changed.  This does 
       not affect any currently existing setups.  Changes include default Load Mode, Click to
       Activate/Deactivate Focus, and Clear Toggles (Sam suggestion to align with user expectations).
    Title plugin defaults when used for the first time have been changed for Drop Shadow (was 2 and
       now is 0) and Size (was 24 and now 48).  More video is of bigger width and height and it was
       difficult to even see the smaller characters the first time (suggestion from Andrea).
    Time-reference metadata value that showed up in Audio examples has been added as necessary for
      “Align Timecodes” (Katacuts supplied examples).
    Updated es.po Spanish (thanks to RafaMar as he has faithfully been providing for months now).
    A new feature is drag speed highlights; it is quite useful because it shows you the change that the
      speed up/down will make to the timeline while moving and then drops it there when you let up on
      the mouse.
    Multiple edit selection capability has been added (Armando forum request “Multiple selection in
      edition mode + BT #494 + Fary54 in the middle of BT #466).

5. Bugs/Issues Fixed:
    Auto-Rotate for ffmpeg video was not working with hardware vaapi/vdpau devices.  Had to rework 
      ffmpeg a/v filter setup and hw decode with vid filters (notified by Ig0r in the forum).
   Speed Auto edit cuts resulted in incorrect results.  This has been fixed as far as we have been able to
      test.  A note about usage is:  “ When working with edits and the speed auto, if you make a "cut" in a
     section, the speed curve values should not change over the remaining playable edits.  It is possible to
     easily add "disjoint" curve points at the boundaries of the edit to preserve the curve shape (houku
     BT #477).
   Paste automation tweaks; undo fixes and tweaks for undo commit logic.
   Normalize speed follows (for example plugins/labels) enhancement.
   Update shortcuts to reflect changes and make some corrections.
   A fix was added to the video code interface with ffmpeg in order to make F_minterpolate functional.  
      Although it will now work single-threaded, it is slow and does not seek so using the command line



      may be a much better way to go (IgorBeg suggestion). Anyway as a result there are now an
      additional 7 more usable ffmpeg plugins available (Andrea went through the set to find these).
   Bug fix for get_auto_at_position equivalence test.

Cinelerra-GG (Version Infinity)  Release Notes for 07/01/2020-07/31/2020 for builds

1. Upgraded several thirdparty libraries to include:
    FFmpeg to 4.3 – with new plugins of asubboost (audio) and addroi, bilateral, cas, dblur, gradients,
       median, photosensitivity, scdet, scroll, sierpinski, thistogram, tmedian, untile, v360, yaepblur
      (video) plugins.  You can use “i” in the Resources window and mouse on each to get short
      information.
    + turbo-jpeg, vorbis, x265, vpx, lv2, aom, and dav1d.
2.  Mint 20 builds are now available and Leap is updated to 15.2.2 (Maigus BT #474).
3.  Gang modes, which includes Gang Channels mode for DAW-like editing, has minor improvements:
    - Using Shift on the gang mode toggle, switches back to the previous mode thus making it easy to
      see a different view temporarily in order to view the actual track lineup.
    - Gang Channel icon in the top line of the timeline, is yellow to help make it clear that you are in this
       mode.  The Gang Media icon is red as a warning of this mode.  The default Gang None is just in a
       theme related ordinary color, often white.
    - A slight change in the order of symbols in the Patchbay has been made for aesthetic purposes.
    - Wysiwig tweak for ganging set of the Master Track for channels.
4.  Align Timecodes feature has been added based on different timecodes or timings included with the
     files.  LTC from external generated audio has not been incorporated due to lack of proper test
     material.  Usage description is included temporarily as a pdf file attached to BT# 448 (which
     prompted this incomplete feature).
5. Tracks Swap Up/Down added to the Tracks pulldown to provide previous capability that was in
     “move up”/”move down”.
6. Usability Improvements:
    In the Viewer window, you can, but no longer have to press Rewind button to start Play over again. 
      This includes play, fast play, play reverse, and fast play reverse (Skinkie BT #463).
    Many FFmpeg plugins required the use of the Apply button before a parameter change would take
      effect.  Now when you type in a parameter change and hit the Enter key, the change will take effect
      (Skinkie BT #464).
    Auto Rotate for ffmpeg video that has “metadata” defining the rotation in 90 degree increments has
      been implemented and is now the default, but you can change this in Settings→Preferences,
      Appearance, Flags (Ig0r forum “Rotation metadata usage in viewer/compositor”).
    Added a dump_stack to the generated crash dumps so that this information is always included, thus
      making user crash dumps more valuable for analysis and potentially fixing the bugs that are found.
    Subtitles now have a choice of format in that menu; srt for SubRip which is now the default, sub
       for Subviewer and udvd which was the original MicroDVD format (RafaMar BT #475).
    Mix masters menu item added under the Window pulldown → Mixers subwindow.  This additional
       feature makes it very easy to get into the multi-camera mixer mode after tracks have already been
       set up and edited.
    When using “File by Reference”  if you exit without “saving”, a reminder will popup to allow you to
       choose to save so that you do not lose work.
    Minor Spanish translation update (from RafaMar).
7. Bugs/Issues fixed:
    The “drag” checkbox for the following plugins has had a major rework done:
        Sketcher, CriKey, Title, Tracer, and Boxblur.  Change prompted by BT #482 from RafaMar which



        was a bug.  Two additional bugs were found while working this problem and have now been fixed
       too.  The “drag” value is no longer saved in the keyframe.
    Problem with resizing the textbox with the Y axis has been fixed (RafaMar BT #456, subtitle).
    The Mask has been tweaked to fix an edge case of 128 cpus which lead to undesirable lines.
    An Index bug that has been around for some time where the drawing on the timeline did not
       complete, has been fixed.
    A reference count has been added in 19 places to keep track of cache as a design implementation
       change to resolve occasional SEGV crashes.
    Fixed break created by creating a clip in OpenEDL edit mode (Fary54 BT #470).
    Fixed a bug in ffmpeg scan remap code.
    Applied a modified patch for configure.ac with a precedence problem in at least 3 different places
      (Ferdnyc supplied patch information in BT 473).
    Hang cinelerra_18388.dmp when use “s” in OpenEDL level (BT #470 Fary54 and Andrea both
       reproduced this bug).
    If Render Farm is enabled and you render a single frame, it was creating multiple output instead of 
      just 1.  This is now fixed.
    ResampleRT plugin to speed up and slow down the audio is now fixed (Houku BT#474).  A fix for a
       segv that occurred while testing has been made also.
    Fixed affine.C and interp.h which are used in the Motion and Perspective plugins, as well as in other
       places, for various boundary conditions (Georgy aka sge, patch in BT #479).
    A mod has been added to fix usage of Paste in the Resources window when preview media is enabled
      (RafaMar BT # 476).
    PatchB for ffmpeg is a temporary patch until a new release that includes this ssse3 patch is available.
       It fixes a padding issue of 16 as 4 was insufficient.
    A fix for another vicon thread lock problem has been added through rework (Armandux BT #481) +
       fixed a discovered problem of vicon interruption during a render operation.
    Tweaked Closed Caption text fonts (for personal use).
    Fixed sync EDL for plugin gui flip out and tweaked plugin gui id’s.
    Changed vrender reconfigure to fix a problem.
    Added listbox selection index range tests to prevent issues.
    Modification made to the build procedure to allow for Cuda version 11.
    A fix to also change the length in OpenEDL of the audio has been added (Fary54 BT#430).

Cinelerra-GG (Version Infinity)  Release Notes for 06/01/2020-06/30/2020 for builds

Cinelerra’s youtube channel can be accessed from the website as set up by Sam.  The link is under
   the Support header - https://www.youtube.com/channel/UCW97mOMN_tAqVCn8k4Euf1w/ 
An update for the Italian wikipedia by MatN and Andrea is now live.
The Elive distro by Thanatermesis has been routinely including Cinelerra for years and so Sam
    has added a link as a choice for users (BT# 453).

1. Add master/armed_gang track operations for closer to DAW-like editing. A method has been
    implemented to treat multiple audio channels as one so that the edits made to the master channel are
    automatically duplicated for each channel (BT 433 / Glen of AVLinux).   For usage details refer to
    the updated manual on the website, section 5.2.1.  This feature is not limited to this purpose as more
    usage scenarios are likely to be quite useful and additionally free up monitor display space.
2. IMPORTANT - Changed Behavior:



    A minor change to “move up” and “move down” tracks was implemented to correct what was an
      exchange on the top track or bottom track instead of a move.
3. Usability Improvements:
    The Perspective plugin has added visible 1-4 numbers on each of the 4 points for ease of use and the
       number of the point is shown next to the X box in the menu (MatN request, BT #443).
    The Rotate plugin has been modernized with improvements by a Contributor.
    A minimum Speed auto value is now used for the update instead of the zero value causing problem.
    FFmpeg will show a “seek retry limit message” for information purposes.
    An easy method to reopen a closed mini-viewer mixer is now in the Window pulldown which
      displays each of the media that occupied a mini-viewer window.
    Minor improvement in Settings→Preferences, Appearance tab to better accommodate languages and
        for aesthetics (MatN contribution).
    The Spanish translations have been improved some more (RafaMar) and minor RU/FR (by MatN).
    Setting and changing Audio or Video track height has been slightly modified and Shift-rmb resets to 
       the original configuration default.
4. Bugs/Issues fixed:
    A patch for the commercials feature was generated and applied (contributed by mehw BT#458).
    The “clear frame” was not working in Tracer as a result of background color, but now fixed.
    Keyframe Spanning was not working for Sketcher, Tracer, and CriKey due to their unique multiple
       points/curves setup.  This was quite a difficult/involved fix (RafaMar BT #441).
    Rework of the plugin presets was completed plus Text was changed to Data for spanning keyframes.
    Some additional code cleanup was performed as usual.
    Embedded object fix – looking for open delimiter followed by closing delimiter.
    Deadlock fix by opening files one at a time.
    Fixed hang caused by an extra lock (Andrew found).
    Reset caches were crashing on vicon drawing, but this has been corrected (Andrew diagnosed).
    SEGV for reset cache fixed as found (in dmp file provided by Skinkie).
    Vicon checkout fix + fixed vicon video/cache errors + address delays created by vicon drawings.
    Cache checkout tweak to remove_all/delete_oldest rework.
    Extract name Valgrind bug fix.
    Fixed some show window deadlocks and X10 remote control memory error.
    An old bug just found, where removing a shared plugin worked incorrectly, is now fixed.
    Collect proxy/nested clips fixes (BT #427 by IgorBeg).
    A new environment variable, BC_TRACE_XERROR will dump the stack on this type of error, thus
      aiding in analyzing any of these types of crashes.
  
     
Cinelerra-GG (Version Infinity)  Release Notes for 05/01/2020-05/31/2020 for builds

First, some notable musings:
- 50th monthly release of Cin5.1/CinGG providing user builds for a number of distros.

- The bug tracking system starting on 2018-11-26 with issue # 1 is working well with a total of 442
  feature requests or problems to date.  There are about 170 open issues and 240 closed ones.

- The partially Spanish translated manual by Sergio has been updated and is at:
     https://cinelerra-gg.org/download/CinelerraGG_Manual_Spanish.pdf

https://cinelerra-gg.org/download/CinelerraGG_Manual_Spanish.pdf


- Wikipedia French version is being updated by MatN and Pierre.

- A very detailed description of how to make a video which includes TIFF images converted from
  raw Nikon DSLR images with Raw Therapee has been written by Richard.  It is at:
     https://cinelerra-gg.org/media/demos/Cinelerra_Transparency_Setup.pdf

1.  Implementation of new Audio features (Glen + others request) include:
     #1 request - Audio track height button now available that is separate from the video track height.
     #2 request – difficulty in coming up with a way to implement combining stereo tracks together.
2.  Upgraded the build system distros to the latest updates available during May.  And updated Arch
     and Tumbleweed on the 30th so it is in synch as much as possible.  Because Leap opensuse 42.3
     reached End of Life in June of 2019, no more builds will be done for that distro.
3. Usability Improvements:
    The last of the Videoscope improvements to include an additional setting request of “Refresh on
       Release” for dragging on the Compositor and Viewer and the TimeBar on the timeline (Pierre
       suggested feature).
    Rotate plugin fixes to include making the + rotate point dependent on the track size, increasing the
       scaling when use the mouse wheel over the rotate dial, and fixing a bug in OpenGL for a yuv color 
       model (RafaMar BT # 422).
    Capability added to individually increase/decrease vertical size of any track in the patchbay.  The
       tumbler icons for most themes were created new (provided by IgorBeg).
    Spanish modifications for translation and tips have been added (provided by RafaMar).
    Plugin expanders and minor French translations added (provided by Pierre).
    An enhancement to the Dump file was made to show what is in cache to help in analysis.
4. Bugs/Issues fixed:
    Transitions at the beginning of a video track were not showing up when the video driver was
       OpenGL, but this has now been fixed.
    A circular situation was occurring when 1 video track using a shared track was pointing at a track
       that was pointing back at the other track.  With the correction when this occurs an error message is
       generated similar to “circular references, track #, plugin_set 0, plugin 0” (RafaMar BT #423).
    Corrected a nested asset audio bug when using clips from the same initial track (Fary54 BT # 425).
    Boxblur plugin had an integer round off problem in the “power” parameter fixed (RafaMar BT #429)
    Fixes were added to avoid memory leaks and other problems as noted by a Valgrind report to include 
       fixes for loss bytes problem in edl.C and performanceprefs.C (provided by Andrea).
    A booby lock problem in keyframe was found and corrected.
    Added a startup lock for LV2 plugins to avoid problems.
    Vicon thread crash has been fixed.  This has been happening for awhile but inability to determine the
       cause resulted in a delayed fix (Andrea noted this crash,  provided number dumps/tests).  Vicons
       are used in the Resources Window as a thumbnail picture of the media and the problem seemed 
       to be only when using the “mouse over” feature which solo-ed the vicon.
    In using OpenEDL on a nested asset in level 1, when the length is modified the change was not being
      propagated to level 0.  This is now fixed (Fary54 BT #430).
    Fixed audio/video module in the nested command setup to solve a problem when loading several
      nested assets resulted in a corrupt audio edit (Fary54 BT #425).
    For the Speed auto, when changing the speed by means of a numerical value, the speed change was
      incorrect but is now fixed (RafaMar BT # 436).  Another problem with Speed auto when set the
      value to 20 instead of 2 was located and fixed.
    Perspective effect was showing a single un-changed frame when used to rotate an image horizontally
      but a mod was created to handle that divide by 0 case and show no image instead (MatN BT #432).

https://cinelerra-gg.org/media/demos/Cinelerra_Transparency_Setup.pdf


    The thumbnails on the timeline were not being updated when using OpenEDL and making edits in
      layer 1 and then reverted back to level 0.  This is now fixed.
    When you drag & drop a nested clip from Media to a new MediaUserBin it now shows up correctly
      in the Resource window (IgorBeg BT # 427).
    Presets for plugins using the Attach Effects menu was crashing but is now fixed (DeJay / MatN).
    The Title of the program window was not being updated when loading a project XML file using the
      Load file pulldown so that is working right now (IgorBeg BT #431).
    A patch was made to correctly propagate gang autos.

Cinelerra-GG (Version Infinity)  Release Notes for 04/01/2020-04/30/2020 for builds

Thanks to RafaMar for a lot of work testing this month, reporting bugs, providing instructive youtube 
videos and tutorials, plus more Spanish translations.

A partially translated Spanish version of the Manual is being gradually worked by Sergio.  This is very 
much appreciated. It is at:      https://cinelerra-gg.org/download/CinelerraGG_Manual_Spanish.pdf

1.  Four potential performance modifications have been made to speed up some places, to include:
      1) Speed improvements for line drawing using Bresenham’s line algorithm implemented now in
          (motivated by LFOM forum notes).
      2) Performance enhancements on the time line for video/audio re-draws has been implemented.
      3) Threading on loads so that Audio and Video can be loaded using multiple cpu-s.  Previously the
          video load to the timeline would have to complete before the audio would start loading.
      4) Hardware acceleration using vdpau for files of type yuvj420p were reverting to software
          decoding on the load due to rejection by ffmpeg.  Another ffmpeg patch (patchA) was added to
          allow this type (used by GoPro cameras) to be decoded successfully on GPU graphics cards that
          support CONSTRAINED_BASELINE (Ig0r in the forum pursued this to a fix).
2. Videoscope additional improvements to ease use in Compositor and Viewer and as a plugin.
    - Smoothed vectorscope so no longer uses fast pixmap but instead software (Sam aesthetics
      suggestion).
   - Added VectorWheel overlay options – none, All, Hue, IQ (with I for skin tones and Q for grass?),
     and user generated allowance by adding to CinPath/plugins/scopes as a png file (Andrea
     and IgorBeg provided initial quality graticules).
   - Modifications were made to layout to improve looks & usage (as recommended by IgorBeg/Sam).
   - Switched the Hue and Saturation values from the top line to a popup instead.
   - Added a “Refresh on Stop” button so that the scopes are only updated when you actually stop the
     play. This makes it play at full speed (Sam suggestion).  Works only for Compositor/Viewer.
3. A long standing serious bug which has been undetected for years is resolved (thanks to RafaMar
    analysis of exact steps to reproduce.)  For details refer to BT #71, note 3228 +.
4. Usability Improvements:
    Switched from png to 90% jpg for ShapeWipe transitions to save binary file size for the monthly
       builds in order to lessen amount of time to download.  Writing software to perform the jpeg
       translation was necessary to do so. This also makes additional 17 shapes available (RafaMar). 
       If user needs to use a png version of a ShapeWipe instead, the manual states how to do so.
     Added to BoxBlur plugin, a way to define a rectangular area for blurring just that spot (Andrea).
     Drag box ungrab for plugins like Title will now automatically turn on the Drag and turn off the Drag
       owned by any other plugin (RafaMar suggestion).
     Collect and Paste effects options are now available as well as saving a stack to the Clip folder (Sam



       suggestion BT #84).  MMB on a track to see. More work is to be done to complete this next month.
     Updated Spanish translation and tips (by RafaMar).
5. Bugs/Issues fixed:
    Problem of Title plugin with long lines or using png with the menu has been fixed (Rafa reported).
    Camera and Projector  “expand X,Y,Z ranges” have been fixed and changed to work a little
       differently but more work needs to be completed (Andrea reported problems).
    Button bars on Compositor and Viewer are now more aesthetically correct and the “meters” icon has
      been moved to the end for a better placement of a non-edit option (Olaf and IgorBeg notes).
    Some problems with BoxBlur to include edge case segv have been fixed (IgorBeg).
    Scaling problems for xinerama case of a screen that is 2560x1080 will now work correctly (RafaMar
      user reported).
    Fixed booby lock problem in ChromaKey plugin.
    Negative value vdpau/vaapi hardware fallback fix. 
    With vaapi enabled, some png’s and jpg’s would not default to loading with software.  Most of these
       will now do so (LFOM report in the forum).
    A bug has been fixed in theora configure.ac (as provided by Andrew).
    Bug in using the next keyframe with the shortcut of “k” was not working if effects not at the
       beginning but is now fixed (RafaMar found).
    Color Wheel Hue up/down toggle needed to be float as was not working quite right.
    Removed “commercials” linking due to lack of use and in particular for the monthly builds which
      will speed up the process.  If building your own, you can put it back in.
    Added requirement to “build prepare” script for Python.  This was found necessary for Ubuntu 20.
    Fixed capture device needed for Recording operations.  This was a dropped line.
    Colorpicker Hue correction has been made in 2 different places (GG found one and IgorBeg).
    Correct alignment for Cakewalk and different themes for BoxBlur contributed by programmer.

Cinelerra-GG (Version Infinity)  Release Notes for 03/01/2020-03/31/2020 for builds

Thanks to Olaf and Andrea - Improvements to formatting for making the Manual easier to read and 
more professional looking were done by Olaf.  Creating new images of better quality and consistency  
were done by Andrea.  Plus corrections and some clarifications were added by them and others.

Thanks to Andrew – Providing patches, alerting us of new versions available, and much early testing.

1. OpenExr has been upgraded from 2.2.1 to 2.4.1 (Andrew notification and assistance).
2. OpenCV upgrade for more recent distros from 3.4.1 to 4.2. Older O/S still at 3.4.1 +(Andrew patch).
3. A major change to ID based references for plugins to resolve a code flaw in copying was made.
4. Usability Improvements:
    To make it easy for moving to the next/previous auto like fade or speed, added Alt-a/Ctrl-a
       shortcuts and in keeping with keyframes, Alt-Shift-A and Ctrl-Alt-Shift-A (Deim31 noted).
    Slider bars have been added to the Projector and Camera compositor menus for ease of use along
       with tumblers to change the range.  All inter-related components are updated accordingly such as
       the zoom bar ranges and the auto xyz lines (Dan feature request).
    Another minor change to the shortcut for “Delete last track” from the lower case letter “d” to Ctrl-
       Shift-D and finally to just Ctrl-d to make it less dangerous but at the same time still not too hard to
       get to (IgorB suggestion for refinement).
    Several new ShapeWipe transitions created by Rafa + others available to load locally.



    The tips file and po file for Spanish were improved once again by RafaMar.
    Videoscope changes (there will be a couple of more changes next month):
        Added capability via an icon on the Compositor and Viewer windows to easily start up the scope
           (BT #71 of Andrea and more recent Dan email).  Changes include the following:
        Replaced menu buttons with a “Scopes” pulldown which is easier to understand.
        Added a “Smooth” button for the purpose of aesthetics for not showing black line missing data.
        Scope values show up without having to play first when enabled or when the window is resized.
        Slider bars with reset button to modify the value for the Waveform and Vectorscope displays.
        Additional choice for the waveform of “Waveform ply” added.
        Note that it may run better with X11 as the video driver instead of OpenGl.
    Mixer window changes:
        - added a “Tile mixers” option easily accessible in the window which was previously only
          available in the Window→Mixers pulldown.
       - “Zoom” has been hooked up (Dan email report).
       - there is now a “Playable” option for each window to save cpu usage time (Dan request).
     Zoom... in the Compositor, Viewer, and Mixer windows has been renamed to Resize Window.
     The compositor button bar has had “Generate Keyframes...” and “Keyframe Spanning” buttons
        removed to make room for the Videoscope button.
     Patches for render options have been worked by Andrew to include:
        EXR - choices of B44, B44A, DWAA, DWAB
        PNG - now has added choices in the render video wrench to include Compression level 0-9 and
                   Depth of either 8 or 16 bits.
        TIFF - new choices of LZW, LZWMA, Deflate.  Tiff now allows for future webp use.
     New plugin “boxblur” to blur horizontal, vertical, and with power.  Very fast; based on ffmpeg’s.
5. Bugs/Issues fixed:
  Format /muxer render new button was fixed as it was not retaining settings correctly.
  Fix for deadlock in Compositor when double click on the indicator bar and trying to drag after that +
     another deadlock fixed when using [ and ] and labels  (Andrew noted and worked to reproduce). 
  Vaapi software fallback fix added so that when non-supported models, like 66, are not supported, the
    software will automatically be in use instead (Jacek BT #383).
  A few tweaks for BSD builds, bld_prepare script added libtool, shortcuts.html and plugin.opts.
  Reverted h264_nvenc and h265_nvenc vaapi render options file back to medium as high was illegal. 
  A problem with keyfame paste track tabbing when trying to go to previous keyframe has been fixed.
  Transition “Length” popup close session hang is now corrected.
  Created image2 for ffmpeg streams when rendering such as in the case of webp (Rafa reported).
  Fixed moving edits with plugins to retain status on/off status (Dan noted).
  Transitions losing their setups when Generate keyframes while tweaking is set is fixed (Rafa found).
  Bug in Shape Wipe jumping when going from Black to White has been fixed (Rafa analyzed).
  OpenEDL problem of saving within a layer so that is propagated up if quit in non-zero layer (Dan).
  Fixed bug in scale.C – autoaspect instead of audioaspect (Andrew found).
  Mixer zoom refactoring and cleanup done.
  DVD creation was limited to 100 sections but now goes up to 1000.
  Home/End keys in some cases had to be hit twice to perform that function while playing – now fixed.
  Crash when loading Exr sequence after files are deleted now gives a warning (Andrew found).
  Aspect ratio in Compositor was fixed when do a split screen view (IgorBeg noted).
  Bad clamps were fixed in the plugins, Color3way and Videoscope.
  Improvement to bluray script added (Sandhill Crane BT#398).  More recommendations provided but
     not yet analyzed and tested.
  Build script tweaks for cross platform - a couple of days worth of testing all of the builds to prevent



     surprises (reflects a lot of Andrew’s work/testing).  Includes lv2 fixes from Andrew.
  Added blur_box as a template (in conjunction with need for Videoscpe) as it will be useful elsewhere.
  Fix for cursor over button bar in the Compositor accidentally playing when Click to Play enabled.
  Segv problem fixed for load server bug that has been in a long time and hard to believe not noticed.
  On the scope window, calculate size of media and how many cpus exist to determine how many
     threads to use; i.e. “load client throttle”.

Cinelerra-GG (Version Infinity)  Release Notes for 02/01/2020-02/29/2020 for builds

A Thank You to MatN for his continuing updates and improvements to the Cinelerra wikipaedia page.  
He has added a table at the start of the page with Cinelerra-GG as the first entry to emphasize that it it 
the one that is being continuously worked and is the most relevant one.

1. Added a Gentoo static and dynamic Cinelerra build in the form of tars.
2. Rewrote and added back OGG for Theora/Vorbis because of complaints about the ffmpeg version
    of ogg being a little erratic in rendered quality and size. This was email and logged to BT # 313.
3. Updated the following 16 libraries to the latest release version available at this time:
    giflib, libjpeg, twolame, tiff, x264, x265, dav1d, opus, nv-codec-headers, libwebp, openjpeg,
    and for LV2 – jalv, suil, sratom, lilvsord, and serd.
4. The monthly build computer Operating System distros have been updated if any updates needed.
    Of note is the upgrade from Mint 19 to Mint 19.3 where several problems have been reported.
5. Usability Improvements:
    New plugin, ColorSpace, has been added to convert color space/range with BT601, BT709,
       BT2020,  and Mpeg / Jpeg along with Inverse as options.  See the manual for a short description.
    In the Resources windows for ffmpeg media under Info/Details, there is now included the Color
       space and range (it will read “unknown” if not one of the standards).  An example would be:
       “colorspace:bt709/range:tv”.  Adding this information was a good suggestion from Andrea.
    More improved Spanish translations from Sergio to include the po file, tips.es, and expanders.txt
       which is the video/audio categorized effects.
    The addition of PulseAudio as a choice for Preferences audio driver is now part of the builds.
    IMPORTANT: the shortcut for “Delete last track” has been changed from the lower case letter “d”
       to Ctrl-Shift-D.  Having just “d” was somewhat dangerous per Dan (Quinton?) because off screen.
    A “format” option button for ffmpeg in the Render menu shows up when you click on the Video
       wrench icon.  This provides a few more tuning operators for the render for choices like mp4.
6. Bugs/Issues fixed:
    Allowing F_colorspace to be visible as a plugin.  Updated Info on plugins and Expander for this and
       new ColorSpace plugin.
    Updated bld_prepare.sh to include Tumbleweed.
    Continuing improvements to the manual for minor corrections and to add any new capabilities. 
      Work done in collaboration with Andrea and MatN.
    Another round for ffmpeg latest git version updated.  Andrew keeps us informed about this so that
      we keep up to date for future ffmpeg official releases.
    A small change has been added so that the “expanders.txt” file, used to categorize video and audio
       effects, can be translated for different languages.  In addition modified Sketcherwindow for some
       missing translatable phrases and a more qualified word.
    The Debian “rules” file has been modified to add dh_makeshlibs and dh_shlibdeps to ensure that all 
       of the dependencies are called for in a package install.  Problem came up on Mint 19.3.
    Changed error message in Render/Batchrender when Create Labels checked but none found (Ed).



 
Cinelerra-GG (Version Infinity)  Release Notes for 01/01/2020-01/31/2020 for builds
              https://cinelerra-gg.org/download/CinelerraGG_Manual.pdf
The newly converted to LaTeX manual is complete and you can view the PDF from the website under 
Download->Documentation→User Manual. From within Cinelerra, the shell cmds icon has a pulldown 
for network access to this manual.  Existing users will have to change the reference in their .bcast5 
directory Cinelerra_rc file from a lower case “m” to an upper case “M”.  Although there have been 
numerous contributors, Andrey’s push recommending latex and setting up the Github and Andrea’s 
conversion of the contents from .odt to .tex made it all happen.

1. New feature of editing/using a File by Reference has been added.  In the load menu, this would be
    the EDL strategy of Reference (uwe request in BT # 318).  Warning on usage is in the manual.
2. WinTV Hauppauge remote control added for over the air TV from within Cinelerra.  This requires 
     a small kernel mod that was checked into GIT.  Additionally the previous ATI x10tv and android
     remotes were modified to provide similar interface.
3. Windows 10 with Cygwin limited Cinelerra build is now available.  See the manual for install and
    details on usage.
4.  Pulse Audio was added as it was needed for the MS Windows port.  You will have to build with it.
5.  BSD patch re-created as it has been 1.5 years since it was updated (Yuri request) and a tar created.
6. Usability Improvements:
    Open EDL, a recently added feature, has been amplified.
    In addition to the Insertion Strategy in the Load Files menu, there is now an EDL Strategy for
       advanced usage to load as a Clip, Nested, or File Reference.
    Group highlighting improvements have been added for drag and drop editing to prevent dropping on
       disarmed tracks and to correctly notify user via color highlights when dropping or overwrite is
       acceptable.  In addition, there is now stickiness when next to another edit making it easy to drop
       exactly next to that edit (IgorB BT # 362).
    Settings→Preferences, Appearance menu has been rearranged because the Flags area was running
       out of space.
    Snapshot and Grabshot default destination has changed from /tmp to $HOME/Pictures so that new
       users will not be surprised when a reboot deletes their work.  Existing users will have to manually
       change the location in Settings→Preferences, Interface tab, Snapshot Path (Rafa suggestion).
    More Spanish translation adjustments have been made by audiovisual technician, Rafa, to include
        the newly added phrases of the last few weeks.  This is on top of all of the Spanish translations
        recently made by Sergio.  Refinement by Rafa is to accommodate the different interpretations of
        the audiovisual world, which is very particular in this regard with some appropriate nuances.
7. Bugs/Issues fixed:
    A build probe fix for a52 has been added, stdint.h (ferdnyc, BT # 359).
    Nested Proxy fix to save the nested files in $HOME/Videos instead of Cinelerra executable
       directory.  This makes it possible that saving your project in proxy mode will work correctly and
       nested files will not get accidentally deleted when install a new Cinelarra (IgorB email).
    Reworked perpetual session load/save strategy to handle levels with Open EDL and undo’s better.
    Fixed 3 lock boobies and minor build cleanups.
    Loaded clips now have the filename and modification time in the comments.
    Left margin for meters in the Compositor and Show Levels is slightly larger (IgorB report).
    Load window filebox resized to be a little bigger so no words are occluded.
    Added a target directory option to the Transcode menu making it convenient for DVD transcoding.
    Fixed broken vicon.

https://cinelerra-gg.org/download/CinelerraGG_Manual.pdf


    DenoiseFFT plugin had a SEGV in an edge case that has been fixed (David analyzed/reported).
    A fix for spurious hard edges has been added.
    Minor one last fix for xft font problem, hopefully the last.
    FFmpeg color space / color range fix but not verified yet (Dejay reported).
    
          
Cinelerra-GG (Version Infinity)  Release Notes for 12/01/2019-12/31/2019 for builds

1.  Init Glyphs finally fixed – at least 99%.  This affects large computers when in highly threaded
     mode and many,  many cpus.  For example, a computer with 2 Epyc chips running Cinelerra-GG. 
     You would see a specific character like the ascii character “b” displayed, usually as “||” instead,
     when running for every occurrence of the letter “b” until Cinelerra restarted.  And on the restart 
     possibly a different character would be incorrectly displayed.  Problem originates outside of
     Cinelerra but a “fix” is now included here and will become more important in the future as users
     upgrade to more cpu-s.  LOCALE changes for other languages will be necessary to include
     characters not in english.
2.  The rest of the HV 7.2 modifications (that fit in and are usable) have been incorporated to include:
     - Compressor Multi for multibands plugin has been added.  The Smooth Only option was
       debugged so that it produced sound and a decision was made to add a Gain and Reset button
       feature at the same time since it was being worked anyway.
    - Compressor plugin had major modifications along with more pot dial options, VU meters, and
       a graphic display.  Cinelerra_factory changes applied also for some automatic presets for plugin.
       This too has had the Smooth Only option fixed and buttons for Gain and Reset added.
    - Reverb plugin ported containing a large amount of changes to include addition of levels, a graphic,
      pots and a full band pass filter. 
    (The previous 3 plugins  were modified to allow for theme related refinements.)
     - Spectogram /Synthesizer plugins were ported as they had a couple of more items/improvements.
     - A dashed center line is now displayed on the Audio timeline when in non-rectify mode.
     - Plugin synchronization fixes were merged in.
     - Changed methodology of truncated text ellipses and modified “align edits” methodology.
     - Refresh frame tweak included.
     - Converted the 7.2 Background plugin to a new Foreground plugin for simple usage of a color.
     - Sound Level plugin reworked to handle fragments.
     - Added Depth variable to plugin.C program.
3. Hardware accelerators improvement is now fixed (found problem as Pierre reported in BT #346).
    This affects Preferences hardware settings of vdpau, vaapi, and cuda.  There may be slight gains in
    decoding speed as a result.
4. Usability Improvements:
    In the Render menu, the filename will automatically have the “.mov” extension added instead of
      “.pro” when pro is chosen for the ffmpeg format for Quicktime type files (Olaf reported).
    Added 13 new audio and 2 new video ffmpeg formats as supplied by Olaf (see Mantis BT # 351).
    New Alpha plugin for the simple case of changing the video alpha value from 0 which is completely
       transparent to 1 with no transparency at all.
    In Mixers, minor changes (issues reported by dankinselman):
       - If in Settings->Edit effects, is enabled, the plugins will be copied/pasted to the master
       track.  Also, labels and keyframes will follow if enabled.  This behavior is different than in the past
       where they were not.  This change also affects when you create a clip – the plugins, labels,
       keyframes will now be included.  This seems to be more correct and you can always turn off Edit



       effects/labels/keyframes if the behavior is undesirable.
       - If close a Mixer window and delete its associated tracks, they will now stay deleted.
       - Mixer windows and patchbay labels are correctly renumbered after deleting mixers.
     The German translations have been updated by Olaf.  Check BT #353 for usage hints.
     The Sketcher plugin has been improved to allow for 2 additional anti-aliasing options to make
        curves and lines less staircase-looking.  Options are off, on, and double (IgorB request).  In
        addition Scaling and Rotation capabilities have been added, layout changes made, and Help
        moved to a checkbox to hide it when not needed.
     Edit EDL capability has been added.  This makes it possible to edit clips, nested clips, and xml files
       in your current project by stacking and unstacking current EDL states. This is documented on the
       website under Download, Temp Storage as editing_edl.pdf.
     Track canvas draw for colored titles and background colors is now fastpath so is at least 4x faster.
5. TV recording changes for over the air digital television changes:
    - Hauppauge 1657 Dual USB device has been tested to work with minor program changes.  A
       possible equivalent European over the air TV might be Hauppauge European Dual Tuner for
       DVB_T/T2/C Digital TV.  But this has not been tested and the channel configuration may require
       Cinelerra program changes and you may need to install TV firmware for your Operating System.
     - The Record menu allows for automatically adding deinterlacing choice of None, Even, or Odd.
6. Bugs/Issues Fixed:
    Updated the ffmpeg git version to include patches for bluray creation (working with Andrew).
    Minor updates to the 3 README.x files in the download area of the website + updated Arch install
       instructions on the website to correct and clarify (reported by v4t).
    Audioscope plugin rework for cleanup and improvements.
    Ubiquitous cleanup done in several routines.
    Colorpicker which was a widget, is now a gadget.
    Paremetric plugin has improved audio play positioning.
    The Apply button in the Load Menus when a selection is available was not getting updated.  Fixed.
    In the Fedora O/S, the cinelerra window icons in the window manager were not always correct but
      this has been mostly addressed now.
    Bug fix for init_colors in bcmodels to clear alpha is now in.
    Transcode fixes applied & more testing led to other possible cases that needed to be handled BT 350.
    Plugins info and shortcuts.html have small updates added.
    Operating System distro and version number are now included in the dump output.
    Minor compositor Zoom change in how it operates when not in Auto mode (BT #344).
    Tracer plugin minor layout changes (reported by Sam in old BT #210).
    Colorpicker gadget/grab fixes and Compositor Eyedropper minor bugs/tweaks fixes.
    Fixed potential infinite loop due to silence not being played.
    One button type did not allow for name changing but now it is fixed to do so.
    The Render Effect menu now resizes correctly for the ffmpeg file type field (Ugin reported).
    Fixed locking labels/plugins/kfs from moving when appending new tracks load (Lukas BT #354).
    Nesting video where audio was deleted and then played in viewer had a SEGV is now fixed.
    Under certain conditions, if you use the P proxy shortcut on the timeline to get back to non-proxy
      mode, it would not do so (but workaround was to use the menu).  This has been fixed to work
      correctly (discovered by dankinselman).
    A fix for the vicon drawing rare SEGV race conditions is now in.
    The beepers in various spots to indicate a render has finished has been consolidated in mwindow.
    Minor valgrind cleanup has been done.
    
 



Cinelerra-GG (Version Infinity)  Release Notes for 11/01/2019-11/30/2019 for builds

Website: Sergio has provided Spanish translations for the website.  This is very much appreciated.

1.  Updated all Operating Systems on the local build machines to be at the latest patch set.  Debian 8
     and Fedora 28 have been retired due to end of life and Fedora 31 has been added.  In addition
     Centos 8 which was just released in October has a 1 time build available, but unless a Xen
     implementation becomes available, may not be regularly built.
2.  Reworked Audio in the area of import samples, resampling, and playback speed sampling.  This
     was a week’s worth of effort as many problems were found in the existing audio playback especially
     when playing backwards, when using the speed auto, and when large buffers were used.  This
     rework fixed a lot of small problems and improved the program code for correct audio playing but
     does not affect the rendered output.  Unless you use a magnifying glass and have exceptional
     hearing, it is doubtful you will notice the difference, but please report any problems.
3.  Some of the original author’s 7.2 modifications have been looked into to include the following:
        Added into Cinelerra-GG, the 3 new plugins – chorus, flanger, tremolo.
        Reviewed Pulse Audio and after merging it in, ended up backing it out because Alsa is much better
          and actually includes Pulse Audio with added improvements to compensate for any deficiencies.
        Better synchronization between audio and Playback was already achieved via #2 above of
          “reworked audio”.
4. Usability Improvements:
    Spanish translation of the po files was completed by Sergio with quite a large number of new
        translations added.  This was a lot of work that is a benefit to many.
    The prores opts files have been updated and include a proxy version for ease of use (Olaf work). 
    Reworked the canvas zoom.  In the compositor, you can now use the middle wheel for zooming
        and moving the video with ease.  Now scroll bars are available whenever image is off the screen.
    Transcode 1:1 is now available in the Settings pulldown which provides a method to convert to a
        different format but most importantly gives the user the capability to be able to seek within media
        that does not have good indexing (see BT 337 for a few more details). 
     Added potentiometer for the “beep on done” in the proxy and render menu so you can adjust the
        volume right from 0 for no beep to 100% for full beep.
     Bluray option file improvements and additions plus a bdcreate patch (Andrew work/discoveries).
 4. Bugs/Issues Fixed:
    Fixed long-standing bug from original software where a specific setup caused a SEGV (reported and
       chased down by Andrew). For details, refer to Mantis Bug Tracker #335.
    Incorrect pix_fmt statements in ffmpeg opts files corrected to pixel_format (Andrew noted).
    Fixes to Compositor Background Color include: play with OpenGL driver retains color; flash when
      restart play in a couple of places is now gone for smoother viewing; the boundary marker is now
      outside the media and does not overlay any portion of the media.
    Small build changes to accommodate Fedora version 31.
    Duplicate close bug in vdevicex11 has been corrected.
    LV2 enhanced gui’s were not viewable in last month’s builds due to missing init but now fixed.
    Fixed hardware device type “none” causing problem as found by Andrew.
    Tweak to “remove assets” was done.
    Voluminous “buffer underflow” when using the default mpeg.mpeg proxy setting has been fixed via
       a patch to the ffmpeg code (Olaf reported).
    Updated about 13 other ffmpeg option files to switch from x264opts to x264-params to avoid
      potential future deletion of x264opts.



    Programmed some index rebuild fixes.
    Fixed audio big buffers bug for libzmpeg3.

Cinelerra-GG (Version Infinity)  Release Notes for 10/01/2019-10/31/2019 for builds

Celebrating 1 year of the cinelerra-gg.org website!  Without Sam, we would not have even started or 
progressed this far and continued onward.  Without Pierre, we would not have had the motivation.   
Now moving forward with assistance of Andrea/Andrey converting the manual to Latex, plus much 
help from IgorB with testing, demos, suggestions, and photo-montages, and then there is all of Andrew 
and Olaf contributions, insights and updates, besides the testing/using/wiki updating of MatN.  Every 
single user who has taken the time to log a bug, do a test, make a feature request, or simply used the 
software helped to keep Cinelerra alive and going strong.  This includes a “Thank You” to the lurkers.

1. Scaling for any monitor to include 4K HiDPI monitors is now available.  For usage there is an
     automatic probe if you do nothing different or you can easily modify the Scaling in the Layout
     section of Settings→Preferences, Appearance tab – be aware that when you click OK, the
     application will restart all by itself.  If you make a mistake in the value you set in Preferences, you
     can workaround this by starting from a window using BC_SCALE=1 {your cinelerra path/bin/cin}
    (orriginal request a long time ago from Terje, +  a post in Forum and BT #25).
2. Updated dav1d library from 0.4.0 to 0.5.0 which has good speedups (Andrew notification).
3. Usability Improvements:
    Several new Shape Wipe transitions have been added to include:
       Butterfly, Circle-s, Clouds-s, Diamond-s, Venetian Blind-s, Cross-s, Diagonal-s, Double Door’s,
         Gravity, Linear-s, and Plasma for an additional 25 (thanks to IgorB).
       Large rework of the Shape Wipe program code to include an additional Feather (blend) slider.
       Update layout of the menu (based on IgorB’s design).
    Icons/pngs mods and additions for Cakewalk theme have been provided.  This includes replacement
       icons for the default Insertion Strategy icons (thanks to Olaf).
    Added Insertion Strategy icons back in for the Load Files, Render, Record, and Menu Effects and at
       the same time cleaned up this code (D. Quinton suggestion).
    Mouse over the effects and transitions in the Resources window will show a short definition when
       “Info on” is enabled via the right mouse button over an empty space or the shortcut of the letter “i”
       (D. Quinton suggestion).
    Added a “Are you sure?” when updating Preferences if a Render or Record is in progress or if a
      Restart is pending (Olaf suggestion).
   Russian translation updated to include many more translations plus fixes (Andrew’s work).
   14 new audio/video opts files to choose for a Render in the quicktime (qt) and avi categories
      (Andrew contribution).
   Qt files now render with automatic extension of .mov instead of .qt because mov is what works.
4. Bugs/Issues Fixed:
    Thirdparty build for Nvenc/Cuda fix has been added.
    Fixed error in the About September Features of note.
    Informational definitions for the Effects and Transitions have been corrected – plugins.txt.
    Booby lock problems in plugin 720to480, updatefilter, and another routtine have been fixed as well
       as another 2 potential fixes as found by Andrew.
    SEGV in popup menu found while using SVG via Inkscape when an empty file name is fixed.
    Rework of the resource_init routine has been completed.
    YUV411 plugin fixed to immediately show a warning message if the session format is not YUV.



    SEGV in Resources Window, Clip folder, when you click rmb, and paste clip when nothing in the
      clipboard to paste, has been fixed (Olaf found).
    Plugin Selective Temporal Averaging radio buttons were not working, but are now fixed (Andrew).
    Plugin Deinterlace-CV had a deadlock that has been corrected and the missing dial is now back
       (Andrew reported this).
    The opts file avi.xvid has been fixed and put into the correct subtype as xvid.avi (Andrew note).
    The differences.pdf file has been updated to include the latest features added.
   

Cinelerra-GG (Version Infinity)  Release Notes for 09/01/2019-09/30/2019 for builds

Special Thanks to Sam for an excellent introduction and description of Cinelerra-GG/Infinity at:
     https://wiki.ubuntuusers.de/Cinelerra-GG_Infinity/
It is worthwhile for users new to Video Editing software to refer to this document to get started on 
using Cinelerra and to get a good general idea of what to expect.  It is in German but easily translatable 
to other languages via the Google translate program.

1.  An optional compiler option of –with-clang was added which allows for compiling with clang for
     about 90% of the source packages as an alternative to gcc.
2. The libx265 thirdparty package has been updated to version 3.1.2 (Olaf recommendation).
3. System builds have had a problem that was just pointed out to us with some third-party packages
    such as libvpx, opus, etc.  Therefore the build procedures have had to be worked differently so
    persons doing distro builds may be impacted to some degree (Solus maintainer BT #303).
4. Usability Improvements:
    Crop & Position plugin is new and is added to the Geometry subset (Anonymous contributor).
    On the timeline, there is now a separator line between tracks for easier visibility (Ugin suggestion).
    In order to provide easy access to 20 of the most recent media or xml files loaded instead of only 10,
        the File pulldown includes a new choice of “Load recent”.  This means that the latest files will no
        longer show on the bottom of the menu which led to varying size and a cluttery look (BT #176).
    Nested media in the Resources window Media folder now provides single frame preview (BT #281).
    Crop Tool in the Compositor is being updated slowly as its existing functionality was quite limited:
       “Do It” button wording changed to “Apply”.
       3 options are being worked of Reformat (the only original option), Resize, and Shrink.
       Allowance for parameter values that are not multiples of 4 by switching to GLx4 usage.
       Disallow negative tumbler values for the parameters.  
       Both Resize and Shrink allow for disarming tracks to prevent the crop from affecting them.
    The Camera and Projector Tools in the Compositor now have F11/Shift F11 and F12/Shift F12
       hooked into the gui menu and with tooltips for easy access.
    The tool gui in the Compositor is now being automatically opened when you click on Projector,
       Camera, Ruler, Crop, Eyedrop, and Mask.  This is more convenient then having to click on the “?
       Show tool info” icon.  Currently you can still use the “?” icon to dismiss the tool gui.
    For demonstration purposes, if you want to put a png file temporarily in the Viewer on initial startup,
       you can add a vsplash.png file to the Cinelerra bin directory.  It is cleared when media is loaded.
  5. Bugs/Issues fixed:
    Render menus now update top line information when you click on “Create new file at each label”.
    Render warnings added:  “no audio or video in asset format” & “render file per label and no labels”.
    Changed Build scripts to special build libdav1d for 32-bit systems (Andrew patch).
    Updated copyright on Settings→Preferences, About screen (patch provided by Andrew).
    Also on the About screen, the August Features of Note was not done but is now (MatN notify).

https://wiki.ubuntuusers.de/Cinelerra-GG_Infinity/


    LV2 blacklist file updated to include 2 more lv2 plugins that fail (Olivier found and let us know).   
    SEGV occurred when could not read anything and then tried to create vicon, now fixed.
    Vaapi graphics hardware acceleration fixed after upgrade to ffmpeg 4.2 changed how it worked (BT
       #304 by Capslock)
    Info in Resources directory has been updated to comment on 15 newer plugins.
    Removed unused and irrelevant timebomb code (Andrew suggestion).
    Info in the Resources window on a nested xml used to SEGV, but is now fixed (Olaf mentioned).
    All of the timeline pulldowns, are a little better spaced between the option and its shortcut (IgorB
       recommended).
    About 8 places in the Cinelerra code, produced error messages of “not divisible by 4 is not
       supported” when using the OpenGL driver.  With the addition of GLx4, these are no longer
       necessary (Andrea notify).
    The parameter in 30 video ffmpeg opts files was incorrectly written as “bitrate” when it should have
       been simply “b” - this is now fixed (BT 305 by kex).
    Put cropp.png in correct location (IgorB notify).
    Fix tumbler text box that was using the wrong data type.
    Rework proxy scalar in order to fix 2 bugs; single images did not scale correctly (BT 194 IgorB) and
      specifying a different file format did not take affect until re-opened but now it does.
    Fix file probe for EXR library in the builds.
    Show Overlays menu required change for using the theme text color for Mode, Pan, & Mask (Olaf).
    A fix to clear all Hard Edges to include the last Hard Edge on the end of the file.
    The Tumbler next to the Font list, only tumbled 1 font in each direction.   This is now fixed.

Cinelerra-GG (Version Infinity)  Release Notes for 08/01/2019-08/31/2019 for builds

1. Upgraded ffmpeg from 4.1.4 to 4.2 (Andrew notification of official release).
2. O/S distros on developer’s build systems have had upgrades applied.
3. Libvpx has been upgraded from 1.8.0 to 1.8.1.  Per their release notes “various changes to improve
    encoder rate control, quality and speed for practically every use case” (Deim notification of release).
4. Dav1d is being used in place of libAOM for decode only in ffmpeg, providing purported significant
    speedups of 2-5 times for AV1 media.  Encode is only available using libAOM so will still be slow
    (Mantis BugTracker #BT 214).  
5. Usability Improvements:
  Mask feathering algorithm has been improved by using an algorithm more close to the original based
     on a user request (User direct request).
   And Feathering which was limited to 100 pixels now allows for a much larger range by clicking on
     the button on either end and sliding at least 12 pixels past that point which increases it by a small
     percentage each time allowing you to move the slider past 100 (User direct request).
   Significant work was done on Feathering by the developer to improve performance and to ensure that
     using OpenGL as well as the X11 driver, produced the same (or almost the same results).
   A Batch Render warning is now shown to the user when the position is at the end of the media (Deim
     suggestion).
   The release in GIT has had a “git tag” added for the “version update” (Mantis BugTracker #288).
6. Bugs/Issues fixed:
    The Compositor “Click2Play” button is now easily accessible again (Mantis BugTracker #BT 237).
    Fixed Render Progress booby (Andrew reported this bug).
    Configure.ac Warn and Guicast Gettid patches (from ferdnyc) were applied (#BT 289 and 290).



Cinelerra-GG (Version Infinity)  Release Notes for 07/01/2019-07/31/2019 for builds

Special Thanks this month (of course, the usual thanks to all involved!):
    Andrea/Andrey are converting the manual to Latex and the long Plugins chapter is now complete.  
    Pierre has updated the French wikipedia for Cinelerra-GG at:   https://fr.wikipedia.org/wiki/Cinelerra
    IgorB has created all of the numerous Masking icon pngs/svgs for each of the themes.
    Sam has updated and improved the website even more – pretty much doing this on an ongoing basis.
    MatN has researched/tested the potential viability of using flatpak or appimage packages for
        distributing Cinelerra-GG to other Linux or Windows distros.  See BT #261 for details. 

1. Prof2, a Profiler that shows where a program is using up time has been checked into GIT.  It can be
    used to determine if Cinelerra or other programs are using too much cpu in any routine.
2. Upgraded ffmpeg from 4.1 to 4.1.4.
3. Masking improvements are now complete and temporarily documented at:
              https://www.cinelerra-gg.org/download/Mask_changes.pdf
    There are now 6 more buttons in the Mask Points section for Point, Curve, or All of Linear or
        Smooth to automatically smooth or un-smooth parts of the mask which saves some tedious work.  
    Cloning and Preset Shapes are now available.  You can Load, Save, or Delete Preset shapes such as a
       Circle, Oval, Square, or Triangle and Save/Load/Delete your own on any video track.
    Center and Normalize buttons have been added to “center” a mask and “normalize” the size based on
       the scale of the video track.
    The Enable buttons can now be used to enable/disable particular masks so that they are not subject to
       any All or Gang functions.  This is in effect for Feather, Fade, Translate, Scale, and Rotate.
    Masking rotate and scale, because they used the wheel, were not included in the keyframe generation
       but now that has been fixed.
    Updated shortcuts.html to include mask editing key equivalences from the Help information.
    Addition of X/Y scaling in 1 direction so that now you have scaling in both directions (default)
       simultaneously as well as just scaling in the X direction or the Y direction.  This also applies tp
       Translate so that you can move a small distance in one direction without impacting the other.
    Now when you enable only Boundary you can see the boundaries of all present masks at that point
      without having to put a gradient behind it to see.
    You can move a mask precisely through use of the textbox in Mask Point section or the tumblers.
4. Usability Improvements
    An additional Settings→Preferences, Interface tab of “Timeline Rectify Audio” provides a choice to
       use this format to have the waveform cut on the zero line, making it easier to note silent areas.
    Spanning Keyframes now has its own toggle so that selections will no longer automatically change.
    An alternative shortcut for Ctrl-m drag/drop editing is the Backspace key.
    Added Compositor background color choice via Settings→Preferences, Appearance (in work still).
5. Bugs/Issues Fixed
    An OpenGL fix for make_shader segment count is now in.  Thanks to reports from DeJay/Andrea.
    A mod has been made to the colorpicker that affects the Title, Gradient, and Sketcher plugins to
       hopefully avoid strange hesitancy behavior.
    Fixed tooltip for “Use HW Device” in Settings, the Performance tab.
    Increased data box size for modes in the Descratch plugin.
    Switched to using the default theme text color instead of white for Show Overlays, Hard Edges icon.
    FFmpeg filters, loudnorm and dynanorm, had invalid setup so were removed from usage.
    In the Viewer, the audio waveform disappeared when playing but this is now fixed.

https://fr.wikipedia.org/wiki/Cinelerra


    Fixed outer color setup for yuv in the gradient plugin
    In the Sketcher plugin, a fix was added for last_xy update in the sketcher grab_event.
 

Cinelerra-GG (Version Infinity)  Release Notes for 06/01/2019-06/30/2019 for builds

1. Encoding GPU hardware acceleration for Nvidia graphics card is now available for h264 and 
    h265. It is built in automatically but you must have the Nvidia driver software at the correct level 
    of 390.25 or higher and a board that supports it on your computer.  In the render menu, choose 
    h264_nvenc.mp4 or h265_nvenc.mp4.  All of the hardware acceleration methods are detailed in:
          https://www.cinelerra-gg.org/download/GPU_potential_speedup.pdf
2. Optional Cuda capability has been added with 2 new plugins – Mandelbrot and N_Body, but you
    have to already have Cuda version 10 toolkit installed for your O/S, a compatible version of driver
    software and you must do your own build.  There is a temporary document with details at:
           https://www.cinelerra-gg.org/download/GPU_potential_speedup.pdf
3. The Masks have had several changes implemented plus additional features to include:
    - Track name is displayed at the top of the mask menu and you can use a pulldown to change tracks.
      Tracks that are disarmed will have a red background and those with masks will be yellow.
    - A Solo option next to the track name allows for automatically showing only the selected track so
      that you no longer have to disarm tracks to do masking on another track.
    - Gui layout modified to include separated title bars to easily find what to change.
    - The focal point for rotation icon has changed from the x to a dot/spot icon provided by Sam.
    - A center mark + has been added to show the center point of the mask and will be the focal point
      when the Focus box is unchecked.
    - An additional row representing the masks has been added so that the user can turn off/on specific
      ones or use the Enable button to the left to turn all off or all on.
    - A Help checkbox was added to either show or not show the shortcuts available for masks.
    - There is now a gang option next to the Focus checkbox that allows for rotate/scale/translate
      multiple masks simultaneously, i.e. “ganged”.
    - An acceleration mouse wheel method for rotation has been added.
4. Usability Improvements
    A gl_probe for OpenGL usage was added to detect GL version 4.3 for the shader so automatically
      uses software instead for computers still at version 1.x.
    The Gradient plugin has been reworked and fixed so that the OpenGL version is now correct and
      the same as the X11 software version.  It also has had the Color Picker updated to work the same as
      the other newer color pickers with an OK and Cancel button.
    The Cakewalk theme has been updated and improved for usage.
    Minor changes to the Shell Cmds with the additional feature added of OnExit Notify choices of
       Never, Always, or On error.
    The blade cut, Hard Edges, green triangles were considered to be distracting to some, so there is 
       now a way to disable displaying them on the timeline via the Window pulldown→Show overlays.  
       This brings up a menu with a new Hard Edges checkbox to show or not show them.  A Clear Hard
       Edges is now available in the Edit pulldown for Clear which clears all or the selected.  Hard edges
       will no longer appear in any silent area and a couple of other areas may also have been changed.
    Clear in the Edit pulldown has a submenu now with 1 more change that Clear Labels will clear all
          labels if no selection or In/Out pointers are set.  Clear Select was added to this also.
  5. Bugs/Issues fixed



      After last month’s transition from 1.x to 4.3 of OpenGL and related changes, more changes were
      needed.  Mods incorporated are:
       - Transparency using OpenGL generally and specifically for the Title plugin has been corrected.
       - Correction to handling YUV in openGL masking is in.
       - Displayinfo update gl_probe for nvidia shader language version has been added.
    TV recording batch path directory was not being set, only the filename, this is now fixed.    
    Sync up mask engine with playback 3d bezier.
    Cleanup done in the Overlay plugin.
    Fixed “drag” checkbox coordinates in plugins like Title, CriKey,… rework/cleanup for render effect.
    The checkboxes for the mask numbers when there are no armed tracks caused SEGV, but now fixed.
    The Title plugin now updates gui if overlay coordinates change.
    If there are no active masks, do not do any checks and do not draw anything to avoid time spent.
    Always insert media at position 0 when using insertion strategy of “Append in new tracks“.
    Changed insertion strategy wording from “Paste at insertion point” to “Paste over selection/at
       insertion point”.
    Corrections for crop vattachment vfrm copy and gl flip_y coords twice (in compositor).
    Fix for use of Render Effect SEGV as discovered by Ugin.  It no longer crashes but without a track
      when using the Title plugin, a different usage method should be used.
    Automatically numbering the Video 1, 2, … in the patchbay in some cases of loading video was
      skipping a track number, so you might see Video 1, Video 1, Video 3, Video 4.  This is now fixed.
    Features5 has been removed from the Doc directory. Will leave a copy in the website download area
      for referential reasons.  Also, changed any references stored in the code base to the manual instead.
    Trivial fix for tiff config without webp. Trivial fix for mask mousewheel segv when no project/mask.
    Configure scripts modified to add with-cuda and with-nv options where auto is in effect by default.
    Updated RenderMux.sh so that in the case of undefined parameter, it should not hang.
    The “Errors” window with the message “The following errors occurred:” has been replaced to be
        more versatile by making it the “Messages” window with the message “Message log:”
    Tooltip added the the Settings→Preferences, Performance tab “Use hw device” to avoid confusion.
    Fixed prores render that was using 422 instead of 444 due to addition of hardware acceleration mods.
    Tessy SEGV guarded against 0 value for Opengl mask operation.
    Fix for Edl change params.
    Raise filebox and compositor toolbox on open.
    In several places, the most visible being the Resource window--Media--Info, the “Fix Interlacing”
      and the “Interlacing correction” fields have been removed as apparently they were only usable for 
      Quicktime DV which has supposedly been replaced by the use of ffmpeg instead.

Cinelerra-GG (Version Infinity)  Release Notes for 05/01/2019-05/31/2019 for builds

1.  Leap 15.1 (Sam notification) and Debian 10.0 Buster/Testing (AJ notification) builds now available.
2. The Canvas lock/refresh was completely reworked with many Mutex-s being corrected to
    Conditions.  Although much testing was completed, there is still a possibility that a deadlock could
    occur under some missed situation.  These could occur in the Compositor or Viewer and if using
    either X11 or X11-OpenGL video driver.  Please report problems for analysis and possible fixes.  

3. The Masks have had several changes implemented plus additional features to include:
    - OpenGL upgraded from 1.x to 4.3 for masking only.  This will affect any operating system that 
       has not upgraded to at least 4.3 and does not have graphics driver upgrades when using Feather.  



       Since 4.3 was released in 2012 this was kind of a surprise until GG started updating for Cinelerra
       masking and found out how difficult it was to do this.   The user workaround is to check the box
       “Disable OpenGL masking” in the Mask menu if using Feather for those computers at 1.x.
    - added rotate and scale around a pivot point to include a Focus X/Y setting
    - now have names for masks instead of just the numbers 0 through 7 and they show on compositor
    - the function feather is a logical function instead of a mathematical function so should be faster and
       now works correctly in OpenGL without the stairstep effect and spurious blobs appearing
    - rework of the mask engine and lots of cleanup done to include correcting keyframe spanning for
      mask auto update_params; fix for mask problem of Mask Clear generating a keyframe at position 0,
      and other minor bug fixes
    - the Mode button for multiply and subtract alpha has been replaced with Fade slider bar with
       positive and negative values
    - a Clear button has been added to delete All Masks for convenience
    - Fade and Feather sliders have a sticky at 0 making it easy to get to 0 and stay there momentarily
    - Gang for fade and feather has been added. This is a symbol to the right of those slider bars and
       looks like 2 links in a chain entwined. As you fade/feather one of the masks, the others will
       fade/feather in relation up to a point
    - Markers checkbox added to turn on/off the points for easier viewing
    - Boundary checkbox added to turn on/off the boundary so as to not interfere with your view
    - radio buttons added, one for each mask, to make it easy to quickly change from one to another and
      in addition the ones in use are in a different color; also a tumbler so you can use the middle mouse
      wheel to go from one to the other

4.  Potential big hint for Nvidia graphics boards computer users - try to enable/disable Vsync in ... 
driver's control application if you use proprietary drivers.  Disable "Sync to VBlank" (option for 
OpenGL) in NVIDIA X Server Settings... has solved the problem!  Thanks to Andrew.  This might help
anyone with an Nvidia card using Cinelerra and having low frames/sec.

5. Usability Improvements
    A flag in Settings→Preferences, Performance, “Use HW” device with 3 choices of none, vaapi, or
       vdpau has been added for using GPU instead of CPU for graphics devices that are capable of doing 
       hardware acceleration.  You may have to restart Cinelerra when you set or change this initially.
    When decoding during a load operation, you can make use of an .opts file to allow for specifically
       using hardware decode or not for a specific video file.  For usage of  these last 2 items, temporarily
       refer to      https://www.cinelerra-gg.org/download/GPU_potential_speedup.pdf
    Encode hardware acceleration for vaapi (Intel graphics board) + 4 opts file (h264, hevc, mjpeg,
      mjpeg2) has been added.
    Color 3 Way plugin has had “clear” buttons added by an anonymous user/programmer.  Convenient!
    The 16 plugins which recently had the Clear feature added, have had a modified Clear icon added for
       all the themes.  This was tedious work credited to another contributor and included all variations.
    Olaf’s Neophyte theme has been updated.  Especially “beautiful” is the About tab in Preferences.
    A new “2019 modern” theme, Cakewalk, has been added and is now the default for users who do
       not have an existing $HOME/.bcast5 file or you can switch to it.  Olaf credit for both themes.
    German translations in de.po have been upgraded to fix some and include a lot more – by Olaf.
    Language translations in fr.po for French have been much improved by contributions from Olivier.
    The Shell Cmds feature has an additional option when doing an Add “run /path/script.sh + argvs”
      which allows for using $1, $2, … args by replacing them with highlighted assets in the Resource
      window.
    



6. Bugs/Issues fixed
    Build tweaks for the newest Fedora version 30 and Tags tweaks were added for debugging purposes.
    Fix for OpenGL Finish – OpenGL was crashing and last month’s temporary workaround is now this
       permanent fix.  Thanks to Pierre using Mint 18.3 which illustrated the bug. CIN_FINISH has been
       removed because it was a workaround in effect when no other resolution was available.
    Title plugin fixes - missing alpha slider and color change on characters now working correctly.
    An error message will popup when the GPU cannot process video to pass back to the CPU.
    A booby trap has been fixed that occurred when you did a cancel on the outline color button in Titler.
    In the Titler, the Stamp timecode box was taking up too much space so had to be moved.
    There was a SEGV observed in vgui / cgui if closed while playing that has now been fixed.
    Updated ffmpeg git option in the build scripts.  The line numbers always change and ordinarily it is
       only updated when a stable and worthy release for ffmpeg is available.
    Added register dumps for the system of user generated dumps to help in analysis.
    A SEGV was occurring because for some unknown reason there was a divide by 0 for width/height
       on a draw refresh.  If the zero divisor condition exists, it will now change it to the number 1.
   OpenCV has been changed to no longer provide the SIFT/SURF algorithms due to murky patents.
   Make_shader routine has been reworked.
   A SEGV destructor error for AC3 has been fixed.
   There was a spurious mask drag tooltip that is now gone.
   Several more contributions by Olivier to repair minor problems include:
     - corrections to the Debian control file
     - the language translation xlat.sh script has been fixed
     - lv2_blacklist.txt additions to avoid incompatible lv2 plugins that prevent Cinelerra from starting
   Five more ffmpeg plugins specific to vaapi usage were commented out as contributed by John/Jacek
     from the Solus team.  It is possible, though not probable, that they would work on some hardware.
   Reworked Shells Cmds to refer to the CinelerraGG_manual.pdf file and no outdated references. 
      However these will not be in effect until your $HOME/.bcast5/Cinelerra_rc is re-created or edited.
   Fixed OpenGL’s transform translate (again!).
   Slight modification to the shell command, RenderMux.sh, in order to create a logfile when used.
   
7. CinelerraGG_manual changes:
    Many revisions provided by Andrea + some cool tables and pngs.
    Formatting and corrections provided by MatN.
    Modified LV2 usage to reflect code changes.
    Replaced some of the JPGs with PNGs for better quality.
    Added a Glossary in the Appendix section.
    Added how to use LUTs in the Tips chapter.
    Added GPU usage with vdpau and vaapi libraries to Performance Tips.

Cinelerra-GG (Version Infinity)  Release Notes for 04/01/2019-04/30/2019 for builds

VIP -  if you have an error starting Cin, look at the error message in the window from where you 
started Cin.  It might look something like this:

error while loading shared libraries: libva.so.1 cannot  …
You will have to install your Operating System’s libva-dev and libvdpau-dev (or libva and libvdpau).

VIP – if when using OpenGL, you encounter a crash occurring in the OpenGL (Nvidia?) code, you will 
have to use a workaround and set the environment variable:  CIN_FINISH=0  until a better fix is made. 
For more details, please refer to MantisBT issue #201 on the cinelerra-gg.org website.  



1. Updated libvpx from 1.7.0 to 1.8.0.   Upgraded LV2 library from version 14 to lv2-1.16.0.
2. New native Tracer plugin added for still images, but works with keyframes if moves.  This plugin
     makes it easy to outline, that is “Trace”, an object with only a few points, kind of like a mask.  There
     is a pdf file with the description of usage.
3.  Potential decode speedup with GPU usage for some computers/some formats via vaapi and vdpau
     with the use of an environment variable CIN_HW_DEV=vdpau(or vaapi).  Computers with Nvidia,
     Nouveau, Amdgpu drivers use vdpau and computers with Broadcom, Intel HD graphics, Radeon
     and other graphics device drivers use vaapi.  Please see the pdf file for details.
4.  15 native plugins have been enhanced by a user contributor to include a “Clear” button for
     individual sliders making it easy to reset just 1 instead of all.  In addition a “Default” button for
     some of these plugins was added to revert to the plugin’s default settings.  Plugins affected include:
     brightness, colorbalance, huesaturation, linearblur, polar, radialblur, rgbshift, sharpen, shiftinterlace,
     unsharp, wave, whirl, yuv, yuvshift, and zoomblur.  Thank you very much to the contributor.
5. Usability Improvements
    A yellow colored “outline” has been added to the Camera view in the compositor in order to more
      easily view location.  Some minor code improvements have been maded.
    You can now nest and unnest multiple clips instead of just 1 at a time.
    Added shortcut shift-d to delete the first track; change "create DVD" to alt-d instead.
    An Apply button has been added to the “Attach Effect” option menu so that multiple plugins can be
      added without having to reopen the window for each plugin.
    FPS and Codec have been added in the comment field in the Resources window for easy viewing.
    Enhanced ffmpeg error reporting to include file name that is causing a problem. 
    In the Proxy menu, when the user checks Scaler on or off, that setting is retained for ease of use. 
    For aesthetic purposes, changed the program code to draw a more symmetrical pulldown arrow.
    The Alt+LMB in the Sketcher has been replaced with Alt+Ctrl+LMB due to O/S grabbing first.
6. Bugs/Issues fixed
    Bug when you play a selection on the timeline and it stops, and when you play again, you have to hit
      space bar twice has been fixed.
    Updated shortcuts.html file.
    Rework update_lv2 for jitter bug + override LV2_PATH in order to avoid hangs for new usage
    An ffmpeg segv was occurring with PAL100/75 bars when not RGB; fix added to only not crash.
    Shuttle driver (not USB_DIRECT) for the new Linux kernel 5.x was broken, but now fixed.
    When using ffmpeg to render, a select file name to render to was not working if there was not at least
       one period or one slash.  This has been corrected.
    A fix was added so that the camera and projector in the Compositor are less jittery.
    A patch was added to ffmpeg code to avoid a SEGV when using YUV format for certain plugins.
    Some non-standard characters, like /, that were not working right in the Titler have been corrected.
    A booby was caught in the Title plugin and has been fixed.
    In masking, a double lock problem in the cwindow and tool window is alleviated.
    Fader slider update for video is now correctly being updated just like the audios in the patchbay.
    The histogram plugin “histogram plot” checkbox when unchecked was still updating when
       Automatic is checked too.  This has now been turned off.
    Ran Valgrind and found some memory leaks that were repaired.
    Added the diamond icon for Bezier versus the default square icon for Linear as used for some autos.
    A case for the Aging plugin was crashing on an edge case that was incorrectly fielded.
    The Sketcher and CriKey plugins had a grab problem but now the boundary test fixes this.
    Serious canvas height bug has been fixed – it was erroneously using “y” as the height.
    Some code changes involving the leaker test were improved – this just helps to find memory leaks.



    Build scripts have been modified to compensate for new GPU usage and to include shuttle.
    Clips folder thumbnails were popping/playing when in the “no play” mode has been fixed.
    CIN_FINISH variable added for OpenGL video driver (GL-ew) as a workaround for segv.
    Two tweaks in Mixer reload to solve a rare case that caused a crash.
    Unset In/Out pointer on “replace current project”.
    Lots of miscellaneous code cleanup. 
    Fix to stop render engine races;  Dialog joins fix.
    Proxy menu fix when scaler is enabled for the size to be correctly calculated.
    Removed the ffmpeg F_interlace plugin because it was problematic.  Use F_tinterlace instead.
    Added Tracer info one line description.
    Fixed too small boxes on Sketcher and Motion51 plugins.
    In order to enable LV2 plugins for ubuntu14, had to add LANG=C99 to the build script.
    A SEGV has been fixed that occurred if you detached Titler/Sketcher with the Color picker up and
      changed it at that point.
    The color in Sketcher was not in synch with the color picker value but has been fixed.

Cinelerra-GG (Version Infinity)  Release Notes for 03/01/2019-03/31/2019 for builds

1. Improved optimization to compile faster.  Although this is not a direct benefit to the majority of
    users, the benefit comes from developers being able to more quickly implement new features since 
    there is a lot of debugging and changes that require constantly having to recompile.
2. Audio Alignment is now available when using multiple cameras through a dialog box.  The audio
    waveform is used with the 2 match methods of Match and Match All, and 2 apply methods of Apply
    and Move.
3. Usability Improvements
    Preview mode in the Resources window now has 2 more options of “mouse over” and “src target”.
    Dvd/Bd create upgrades, rework, cleanup, and minor fixes.  There were also Dvd/Bd render farm
       tweaks to use new raw video option file for ffmpeg.
    Layouts for screen positions now allow for descriptive names for easier identification.
    Modified Shuttle to allow for usage in multiple instances (only works in non-USB direct mode).
    Insert Mixers has been added which works like Open Mixers, except the mixers are added on new
       tracks at the insertion point instead of at the start of each track.
4. Bugs/Issues Fixed
    A booby trap lock problem was fixed in the Remote Control program.
    Batch render cleanup.
    Fixed segv that occurred when using multiple full screen viewers or mixers.
    Pan widgets upgrade modifications.
    Erroneous “render farm” usage printing out after batch rendering has been corrected.
    Patch provided by Daniel to handle sig’s for PowerPc building has been applied.
    Default window positions modified to accommodate 3 monitor setups without looking weird.
    Preset edit for plugins had title names incorrectly moving in the display.
    Removed warning message that was not informative - mov_sphere=0 jpeg_sphere=0.
    Labels were not being correctly retained when “edit labels” was unchecked when saved.
    Fixes for DVB usage to android remote control and Xinerama full screen.
    Resize “preset edit” window fixed to correctly retain the Y coordinate.
    Fixed av format via ffmpeg leaks and conditional jump problems as found by Valgrind (Andrea).
    Track dump tweak; Sketcher plugin tweak; zwindow refresh EDL fix.
    Histogram bugs (2) were fixed – bad vertical line and noise in image + allow for tumbler up to 100.



    Do not create thumbnails in Resources window flag was inadvertently not working.  Now fixed.
    Caught another booby in the bird trap (Andrea catches them a lot!) on save/quitting.  Fixed.
    Fixed problem where labels were not always retaining multiple line commentary.
    Corrected initialization for Preset in Settings→Format for 6 channel location for 1080p/24.

Cinelerra-GG (Version Infinity)  Release Notes for 02/01/2019-02/28/2019 for builds

1. AV1 and WebP decode and encode are now available in Cin-GG if using the standard builds.  This
    involved adding these 2 thirdparty libraries: libwebp-1.0.2 and libaom-v1.0.0 .  There are new
    ffmpeg opts files to allow users to render to these 2 formats: webp.webp and av1.webm .  The webp
    format requires that users have libtool installed.  Ubuntu14 and Debian 8 do not have these included.
2. Many thirdparty packages have been upgraded to include the latest versions for:
    x265 version 3.0, fftw-3.3.8, libogg-1.3.3, libvorbis-1.3.6, openjpeg-2.3.0, opus-1.3, tiff-4.0.10, and
    libgif 5.1.6.  A new format choice of jp2 is available for openjpeg 
3. Gif native capability has been completely upgraded to allow for reading and writing the gif format
    in singles, sequences or lists.  As a side effect of this effort all of the other sequences have had the
    letter “s” added at the end of the extension filename automatically generated on a render.
4. Deleted code for native ogg/vorbis because too many errors/not working and ffmpeg version better.
5. Because this affects most everything, be advised the the transport queue and playback engine were
    reworked, initially for shuttle speed control, but then it was determined that if a user keeps pressing
    keys really fast so that there are many queued up commands some may be thrown away.  Although
    with much help from the users, it is possible that there may still be issues with locks.
6. All of the O/S distros on the build machines here were updated in order to add the libusb library as
    needed for USB Direct usage of the Shuttle.  If doing your own builds, you will need to rerun
    bld_prepare.sh to get the included libusb requirements.  README.arch on the server has this added.
7. Usability Improvements
    Two new shortcuts added to create identity keyframes for camera and projector, Shift-F11/F12.
    Ripple method for drag handles has been reworked to be the old method; Edge switched for new.
    DVB channel / tuner api has been upgraded / improved to replace deprecated code.
    Load menu has had some informational fields added to make it more understandable for new users.
    Added fps calculation when using Batch Render from the command line with the render farm.
    There is a colored box representing the currently chosen auto on the zoombar at the bottom of the
       main program window, as well as to the left of the message, of the same color as the line to make it
       easy to see which line type is being manipulated.
    Transitions now can use frames/hhmmss:frm/hhmmss:xxx instead of just seconds for the length.  In
       addition you can use the mouse wheel to change the length in real time.
    Changes to the Shuttle code from testing and feedback of Pierre includes the following:
       Addition of ShuttlePRO to the PROv2 and Xpress has been added as another device name.
       Composer/viewer fullscreen modes now work with the shuttles.  
       The rules file is now available as it had been inadvertently left out of last month’s builds.
       Instead of only 3 forward and reverse speeds, there are now 6 of each and they can be defined in
         decimal numbers as well as integers up to and including 64x.
       S0 position on the wheel was not generating a signal so the S1 and S-1 have to be used for Stop.
       The default shuttlerc file has been tuned by Pierre and Phyllis to reflect the more useful settings.
       Shudmp file is included in Cin’s distribution for use in checking your Shuttle hardware.
       Removed regex from usage with the shuttle as of little use for Cinelerra.
       There is an alternative usb_direct usage instead of going through the hid generic driver; this
           required new 99rules and shuttlerc files.  It is recommended for usage to ensure K14/K15 work.



       Added Alt, Ctrl, and Shift with character options to allow for more assignment key options.
8. Bugs/Issues Fixed
    Makefile clean tweak, ydiff ffmpeg tweak, delete old CHANGELOGS, fix downloads.txt.
    Fix editpanel window lock issues.
    Use undo bracketing to avoid stop playback deadlocks.
    In Drag and Drop edit mode, a silent selection between 2 edits would crash while dragging.
    The usual ongoing cleanup was done while modifying code.
    R-usage has been added to print out the CPU time used when Quit if running from a terminal.
    Size of Font box in the Titler has been increased so no need to scroll to see the full name.
    Fix single step jitter.
    A jpeg file of odd dimension instead of divisible by 2 was causing a segv but fixed now.
    Added another booby trap to catch potential problems.
    Camera drag tweaks incorporated.
    Viewer selection criteria was incorrectly set so that frame forward was going to the end instead.
    Sync parameter fix put in.
    Shortcuts.html updated for missing or new shortcuts.
    Ripple and Slip had some problems with “follow edits” and “keyframes follow” but now fixed.
    At least 3 batch render boobies were caught and fixed as well as a C41 plugin booby + track resize.
    The Rotate plugin crash was fixed + some other rotate with 0 problem + fixed for some translations.
    Build scripts now allow for any Python level rather than restricting to Python3.
    Another change for builds is to check for x86 or x64 before compiling any assembly code.
    The fps for still images has been set to 10 fps.

Cinelerra-GG (Version Infinity)  Release Notes for 01/01/2019-01/31/2019 for builds

1.  The O/S for all of the distros that are used in creating the monthly builds have been updated.
     This takes an intense 2 days of work for a little over 20 distros and usually gets done quarterly.
2.  x264 and x265 libraries have been updated to the latest version at the time.  And it has been
     recently brought to our attention that if using x264, you can do 10-bit as well as 8-bit with the
     standard monthly builds (thanks to Terje notification).  For rendering, the opts video file for x264-
    10bit.mp4 has been added to facilitate usage. 
3.  Cin now supports the ShuttlePROv2 and ShuttleXpress devices and can be user modified.
4.  Drag Handle usage has been reworked.  Besides Ripple, Roll, & Slip, there is now Slide and Edge.
5. Usability Improvements
    Add double edge insert and overwrite with highlight.
    “Fast” drag mode now allows for moving the effects, labels, keyframes, and autos along with the
        clips and honors the Settings pulldown checked items.
    Reset buttons have been added to 23 more plugins: Brightness/Contrast, Gamma, Hue Saturation,
        ReframeRT, Sharpen, Polar, Wave, Whirl, Blur, Radial Blur, Linear Blur, and Zoom Blur, Oil
        painting, Unsharp, Rumbler, YUV, YUV411, YUVShift, Swap Channels, ShiftInterlace,
        RGBShift, Translate, and Swap Frames.  Contribution from another programmer.
    You can now dump the last 32 un-do’s in the undo stack on your terminal window if start cin there.
    Because cut and paste behavior was new last month, there has been some minor changes and 
       additions to fine-tune specific areas.
    Groups can now be single source dragged.
    
6. Bugs/Issues Fixed



Thanks this month to all of the users who took time to report bugs in MantisBT.  It takes your time 
to do that but everyone benefits.

    The Dump Assets in File pulldown was crashing but is now fixed.
    Delete_edits optimize was causing a crash in drag and drop mode.
    Code cleanup to combine 2 separate color header files.
    Updated CineRmt which provides a remote control for using cinelerra on broadcast TV.
    A bug in ReframeRT with the settings has been fixed.
    Fixed bug in Rotate plugin of an issue when you move the draw pivot out of the canvas on bottom.
    Rework paste edits to accommodate new capabilities.
    Removed “code for lost auto” put in February 26, 2018.
    Changed build scripts to not allow an mjpeg v4l, non-version 2, build.
    Fixed Tip of the Day to rotate through the tips instead of always showing the same one.
    Create separate groups instead of adding to an existing group.
    Expanders.txt has had an additional time plugin added.
    Batch Render has been fixed to report the filename when it gets an error (was null).
    Render Farm had an additional field (now 6) added awhile back that caused the batch render 
       columns to be incorrectly recorded because it only had 5 columns.  This has been fixed.  Users
       who change from batch render to render farm MAY BE IMPACTED but the workaround is to
       delete the $HOME/.bcast5/Cinelerra_rc file.
    DVB channels/tv fix ups as prompted by work of MatN.
    Removed build requirement of ESD sound driver.
    Batch render segv on boot defaults fixed.
    Blue Banana plugin bug fixed where a draw was happening inside destructor code. 
    A potential hang when freeing locks has been corrected.
    Mjpegtools has been modified because there was a typo.
    The default ffmpeg audio and video icons were corrected with Sam’s logo (a mistake here).
    Shortcuts.html accessible from Cin has been updated.  Differences.pdf was updated on the Server.
 

 Cinelerra-GG (Version Infinity)  Release Notes for 12/01/2018-12/31/2018 for builds

1.  Inter-View mode / Identifying Source Targets shows in the Resources window preview are
     where the media is used or unused plus allows for seeing that portion in the viewer and positioning
     along the timeline.  Usage is easy but not immediately obvious, so refer to section 46 in Features.
2.  Cut and Paste behavior for moving, deleting, inserting, and grouping edits with various options
     has been added.   And the selection process makes it possible to add transitions to multiple edits.   In
     the same area Dragging changes and improvements have been made.  See Section 47 in Features
     for details (or just middle mouse button on a track to see the options).  Labels, autos, and keyframes
     will also be moved along in this new drag method but that feature has not yet been incorporated in
     the old drag method.
3.  Color titles per media/proxy files is now an option with Autoselect colors (Settings→Preferences,
     Appearance tab) or Self-color.  Refer to section 48 in Features Pdf file to details.

Super Testers this month for the above 3 new features deserve special thanks for testing, feedback, 
and patience to include Andrea, IgorBeg, Pierre, and Sam.  It made development a lot easier.



4.  Because this is pervasive, a bugfix to Draw/ReDraw on the timeline is emphasized here to make
     you aware that in spite of testing, there could still be an issue.
5.  Usability Improvements:
     View Thumbnail size, Vicon memory size, and Vicon color mode are now settable in Preferences
     to allow for bigger or less pixelated thumbnails when previewing.
     Preview window zoom scale for vicons in the Resources window using the middle mouse wheel.
     Video plugin expanders in Resources now has more categories and is improved thanks to Andrea.
     Cut and Paste editing mode (I-beam) now allows for grouping and column dragging.
     Shortcuts for “Align cursor on edits” and “Save settings now” have been added.
     New drag arrow so can see behind, for all themes except Bright, Blue Dot, and Neophyte.
6.  Bugs/Issues fixed:
     Last month the following was mistakenly left out of the release notes – for deleting icons in the
       Resources window, the shift-delete  control was replaced with Ctrl-shift-delete
     Upgraded bccmdl.py to python3 – credit to Frank Dana of rpmfusion.
     Reworked vicon view popup in order to add more capability.
     The Proxy preview has had 2 bugs fixed that led to bad behavior in the Resources window.
     A bug with listbox usage in the Titler plugin for font choice that made it more difficult to choose has
        been fixed.  The fix affects all listbox but there should not be any repercussions.
     Drag and Drop mode had the white box highlighting incorrectly positioning; now fixed.
     Highlighting in the Resources window problem is now working correctly.
     Fix for vframe get_frame sporadic crashes when creating clips, or using Sketcher/CriKey.
     Placement for Vicons preview has been slightly modified to work better.
     Proxy with multiple viewers switch under certain conditions had a SEGV; now is fixed.
     Fixed crash occurring when removing from project while a preview of a thumbnail was playing.
     A problem with Proxy that had audio, which does not have a index, has been corrected.
     The drop position in Drag and Drop mode was incorrect in some cases.  This has been fixed.
     Package creation, etc, for rpmFusion (credit Frank Dana) has recommended some improvements
        that make packaging more current mainstream.  This includes adding noexecstack option on load,
        ensuring the executable bit is only set when necessary, and updating the desktop cin icon.
     Updated COPYING file containing GPLv2+ GNU General Public License.
     Double delete in Titler was found and fixed.
     Default proxy ffmpeg/mp4 selection had an incorrect setup so switched it to faster mpeg.
     Minor fixes in the Preferences sections for French language translations that were corrupted.
     Fix for filebox apply button on resize has been applied.
     Phantom keyframes showing on the timeline are now gone.
     Some leftover references were corrected to point to cinelerra-gg.org.  

Cinelerra-GG (Version Infinity)  Release Notes for 11/01/2018-11/30/2018 for the builds

1.  Ffmpeg upgrade to 4.1 with several new functional cinelerra plugins that work with cinelerra.
2.  New Sketcher plugin added to be able to “pencil in” information and draw circles/lines.  Intense
     testing was done by IgorBeghetto + a good set of suggestions that he made were implemented.
3.  Usability Improvements:
     For the autos, added double click Button 2 use to select keyframe position.
     There is now a Proxy folder preview in the Resources window – same as what was in Media.
     Multiple contributions from Andrea Paz to include:
        - Testing of the LV2 lsp-plugins by Andrea Paz has resulted in adding “compressor” ones to the 
          lv2_blacklist.txt file since they failed in Arch for sure. 



        - Valgrind runs helped to ensure very little memory loss and no illegal instructions for new code.
        - Tested and verified updated ffmpeg plugins and retested a couple of old ones that now fail.  As a
           result there are now an additional previously existing 8 plugins and 15 new plugins with 4.1 that
           appear to function.  Added helpful, instructional comments to the plugin.opts for future use.
     Updated “info” for the additional ffmpeg plugins and added vibrance and fftdnoiz to expanders.
     Load window now has a middle Apply button on the bottom to facilitate multiple directory files.
     The OK and Cancel X button were added to the Title plugin so easy to revert to original with the X.
     Added alpha to the vframe draw_pixels in order to allow alpha for sketcher, etc.
     The Delete key shortcut was added to only “Remove from Project” the selected Resources media.
     Window layouts can be saved and reused (total of 4) which provides more flexibility.
     The Resources asset popup includes a choice to select all used on the timeline or all not used.     
4.  Bugs/Issues fixed:
     Reverted for autos to be able to double click for ganging without “tweaking” enabled.
     OpenCV which allows for use of FindObj, Move, Gabor, Stylize, Flow, and Puzzle is relegated to
         remain at version 3.  Attempts to upgrade to version 4 bring up license issues of non-free.
     FFmpeg message about some stream times estimated has had the filename added for reference.
     Dynamic Keyframes problem which causes undo to not work or possibly crash has been fixed.
     Replaced cin logo from Sam (most likely accidentally checked in the wrong one originally).
     An “edge” case with keyframes has been corrected by adding a lock around that code.
     Minor keyframe read-in rework was done.
     Shared effects under certain circumstances were being selected off by 1.  Two bugs fixed.
     Some changes to listbox to include 1 bug fix and minor additional capabilities.
     CriKey plugin code tweaks.
     Code in vframe.C was moved around a small amount for better readability.
     Bad resize of the Load window when the “recently used” pulldown was used, but this is now fixed.
     The Title plugin Color Picker code was updated to prevent sharing problems with the Sketcher.
     PPM code had a vframe fix applied.  Fixed blue_dot/blond_cv error.  Hard edge edits were tweaked.
     Increased retries from 100 to 1000 in ffmpeg encode_frame for flush.
     Modified version number from Unify to Infinity and created allowance for previous XMLs.
     Shift-Delete to remove a plugin has been changed to be Ctrl-Shift-Delete instead due to a conflict.
     

Cinelerra-GG (Version Infinity)  Release Notes 10/01/2018-10/31/2018 for the builds

1.  Effort to make Cinelerra-GG Unify a more complete package with more individual contributors:

     Trim Feature enhancements for drag handle playing and splitting compositor to show both sides -
         usage in 41.13 of Features5.pdf.
     Search capability in the Load menu at the top underneath the directory name.
     Added 22 more usable ffmpeg plugins such as Color/Tblend/Mandelbrot/Tile.  Credit to Andrea
        Paz who tested hundreds and some more of these will be added later.
     French translations mods from Olivier (along with credit) have been put in.
     App icon modernized with credit to Creative Common (Sam).
     Title plugin is no longer limited in number of characters dependent on system resources.
     Dynamic Keyframes are now the new standard with very large numbers possible.
     Expandable/Subtree capability now available in the Resources window which allows for
        categorizing specific plugins such as Color Correction filters, Motion, and LV2 Calf plugins.
     To standardize to GPL-only licensing, replaced libfdk_aac with aac, changed related opts files and
        removed a few fonts of questionable license (credit to Olivier for persuing this effort).  There is a



        workaround for users who do their own build to put back libfdk documented in Features5.pdf.
2. Usability Improvements:
    Modified autos, such as fade, to allow for textbox input and tooltip-like value representation (this
       welcomed suggestion originated from Lukas).
    Reload plugins index option added in Settings→Preferences, Interface tab, needed for testing and
       when additional plugins are added.
    Info plugins.txt updated to include very short information for the recently added ffmpeg plugins.
    When creating clips, if you number the clip a higher number, the next clip will use that number +1.
    The plugin icon for cinfinity when the controls window is activated will be displayed in the window
       manager set of open windows.  A default icon of the green GG was created for non-existent ones.
    Histogram Bezier plugin makeover based on user feedback/testing and user suggestions:
       - keyframe problem of modifying the previous instead of the current keyframe has been resolved
       - control points and previous/next keyframes problem is fixed
       - default threshold changed from 0.1 to 1.0 thinking that was in error
       - interpolation type on pulldown menu now shows the right type with the graph
       - Split Picture checkbox is now saved with the keyframe
       - position of the point's handles is now recorded correctly
       - the code was cleaned up and several small bugs that may not have been noticed by users fixed
       - added a "Clear" button on the right hand side of the Value, R,G,B which resets the chosen one
       - shortcut is available to delete a drag-point with right click in addition to the current Delete key
       - speedup by reducing the lookup table space from 65k to a smaller number when possible
       - the white background was too bright and hard to see the colors so used improved colors
       - a separate yellow colored line was added to indicate the gradient
    Improvements from the work of Olaf Wolff multiple contributions include :
      - Neophythe theme update with new icons and different colored window place holders
      - German additional translations or corrections provided
      - recommended deleting old unused icons in the data directory to avoid confusion
      - provided license wording for CC credits to use in the Settings→Preferences, About tab
      - checked out inkscape changes and notified developer to correct the dpi setting
      - generated valgrind output which illustrated code that was losing memory so developer could fix

3. Bugs/Issues Fixed:
    Keyframe error while tweaking has been fixed.
    Potential SEGV avoidance with keyframes when set to Null.
    Corrected version spelling from “Unity” to “Unify”.
    Perpetual Session settings saved bug fix.
    Updated Cin.po so that the latest phrases are included.
    A “checkpoint undo” has been added whenever a “perpetual session” save is done.
    Ladspa scroll fix applied; lv2 listbox scroll fix applies.
    The lv2_blacklist.txt file has had some additional problematic files added (credit Olivier).
    Textboxes have been reworked.
    Fix utf8 keycode versus wide key symbols which resulted in Cyrillic code inputting incorrectly.
    The splash gui black letters switched to a lovely green to show status such as “Initializing Plugins”.
    Audio click problem for some files has resulted in a code change to accommodate different cases.
    The About icon was a little too big on Leap systems, so it was moved a little.
    Changed composer to chroma only, no source alpha blend, affecting fade so that the OpenGL and the
      X11 software looks the same.
    Blue banana slider fixes put in.



    Plugin close deadlock detect has been corrected.
    Error in clip folder for some old projects, is now putting the clip in the Clip folder instead of Media.
    Cinelerra_presets error message if no specific user file is available is now ignored.
    Change to transition effects occurring in clips within a cut area has been modified to not take effect.  
       If user wants the clip to include the transition, have to use nested EDLs unless matches exactly.
    Background rendering when enabled in Settings→Preferences, Performance takes effect on Apply.
    Editpanel modified so that “Click to Play” state is saved with the project.
    Histogram has had the default threshold changed from 0.1 to 1.0.
   

Cinelerra-GG  Release Notes for 09/01/2018 to 09/30/2018 for these builds

1.  Removing descriptive version number of 5.1 and replacing with Unify and GG – just in places that
     an ordinary user will see.  This does not affect build scripts, pathnames, or other representations that
     builders or developers can easily view.  New Splash Icon by Sam and temporary App icon.
2.  German translations and newest Neophyte theme are being maintained and updated by Olaf.
3.  Local Build computer has had all of the distros updated to current releases.
4.  Added Export Project to file pulldown for more easily moving files to another computer (see
     section 40.28 in Features5.pdf).
5. Usability Improvements:
    Added line between In and Out pointers to better see defined area + you can drag either pointer AND
        a label by left mouse button clicking on the icon and left mouse button drag to another location.
    Ffmpeg scan error now will include the filename in the terminal window error message.
    Changed the way the camera works in the Compositor to be more intuitive for dragging the
        viewport, that is “move the camera with the mouse”.
    Motion51, and the other 4 Motion plugins now have more visible lines since they are thicker and
       should display properly on almost all monitors.  They are now stippled black and white.
    Numeric keypad additional keys of Minus, Plus, Period/Dot, and Enter now also work in dialog
       boxes.  Same as the numbers 0 through 9 added last month.
    User bins/folders can be set up with relative paths by holding down Shift key when ready to drop.
    For mp4 rendering, you can now choose h264/5_mp3 Audio instead of the default aac Audio.
    Added option to easily check box on/off all XYZ of camera and projector (see Window→Overlays).
    A Shift-LMB on the Overlays window checkbox will allow for creating a “hot” button with only that
       item checked and then reverting to the “cool” state of the previous selections (see 32 of Features5).
    The Patchbay has been modified concerning the Expander in conjunction with allowing for 
       “Show Titles” only to work.  The expander icon toggle will now let you see a single asset and title.
6. Bugs/Issues Fixed:
    OpenGL texture mod to prevent problems due to Vframe and pbuffer not divisible by 4.
    Previous and next labels in Viewer were incorrectly taking effect on the main timeline instead.
    Modify Folder window increased size to make room for language translations.
    Rescale refresh_frame for X11 direct scaling.
    The fullscreen mode for a 3 monitor system has now been corrected to respect the space for the
       compositor and viewer. 
    Fullscreen focus for the Compositor and Viewer has been slightly modified to fix problems where
       the use of the F to return to normal mode was occasionally not working.
    Another focus change was added to alleviate the switch from fullscreen to normal size screen
       causing some kind of lockup where the 1 and 4 transport keys stopped working.  However, this did
       NOT FIX the problem so still searching for reproducible scenario in order to fix it.
    As usual, some program file cleanup.



    Shortcuts.html changes made to include Timebar and new shortcuts.
    Bug in h265 render format for gbrp is now fixed where the wrong colorspace was used.
    Added Mat N.’s patches for mpeg2enc and mplexlo to get rid of many warning errors.
    Fixed Viewer LMB+Ctrl which was inadvertently changing the time format on main track canvas.
    Correct alpha calculation in overlaysample.
    The Label comments popup is now honoring the ESC or X to not make the comment changes.
    OpenGL tweaks to include: edge jitter/glitch fix , projector + zoom GL fix, and zoom slider fix.
    FFmpeg plugins have been fixed so that when the selection is changed, the scroll position is not lost.
    Increased window size of Preferences to accommodate 2 of the themes.

5.1  Release Notes for changes from 08/01/2018 to 08/31/2018 for these builds

1.  Bins / Folders are now available in Resources window.  See section 45 in Features5.pdf for usage.
2.  Neophyte theme, courtesy by hard work of Olaf is selectable in Settings→Preferences.  It is very
     colorful and a really good presentation.  As always, “thanks”, and other themes welcome!
3.  German translation massive improvement compliments also of Olaf (another good-guy).
4.  Usability Improvements:
     Changed Preview Bar behavior in the Compositor and Viewer so that if not turned on, any media
        added to the timeline that increases the length, does not “turn on” the Preview Bar (Olaf described
        the issue with sufficient detail for us to understand the confusion, especially for any new users).
     You can now use numbers on the keypad in dialog boxes without interference with transport keys.
     Added a couple of extra pixels in Resources window display between icons for better readability.
     An ffmpeg ffv1 format has been added as provided by Olaf – under mkv, matroska container.
     Vicon changes in the Resources window:
      - With the Preview / Draw Vicons enabled, if you single click one of the Media vicons, a
        “mouse over” capability is enabled, with another single click to disable.  This is documented in
         section 12 of Features5.pdf.  This new implementation is subject to possible future change.
      - Vicons looking like they were jumping when playing has been fixed.
      - A resize to show files that were not showing were not playing, but this is now working.
      - Hide vicons was not working correctly, but should be now.
      - Vicon drag and performance tweaks were added.
      - Vicons now remembers where they left off, and restart there instead of starting over.
5.  Bugs/Issues Fixed:
     One condition, when using the Ctrl-r shortcut for proxy, was inadvertently leaving the icon in the
        wrong state has been corrected (reported by Igor Beghetto).
     Waf problem with LV2 for Arch has had a patch added.
     A bad window reference to listbox has been fixed.
     Labels and In/Out pointers in the Viewer were not being highlighted correctly and now is fixed; also
        the Prev/Next label buttons were incorrectly showing in the main track canvas.
     Sort by time has been removed in order to accommodate sort in bins/folders.  Sort of filenames is
        now without the directory path – just the basename.
     Added a awindow copy fix which solved clips initialization problems.
     Unterminated clip comment workaround in old XMLs has been added.
     Safe regions in the compositor were not being re-displayed after playing stopped.
     Another “booby bird trap” error has been fixed.
     Double click on proxy file which was video only with no audio was not going to the viewer – fixed.
     OpenGL refresh_frame and rework done, mostly for the sake of overlays in the Compositor.
     A Scalar Proxy race condition is fixed.
       



     
5.1  Release Notes for changes from 07/01/2018 to 07/31/2018 for these builds

1.  FreeBSD unbundled build script is now available.  Yuri has ported Cinelerra-GG using this as a
     basis and has added the package to the freshports.org website.  Yeah!!
2.  Locked all XFT drawings.  Although this may slow character drawings down a little, this is at least
     a 6-year old bug in the X library that no developers want to fix so am providing a cin5 local fix. 
     Also, set up a trap to catch any that might have been missed (only traps if compile –with-booby). 
     This only fixes 2 out of 3 of the bugs found.  A bug report was sent to freedesktop.org (107380).
     There was code added to window and other create object areas to lock/unlock to prevent issues.
3. Usability Improvements:
   Added a choice to “beep” when render is complete in order to notify you if busy with something else.
   Ctrl-a and Ctrl-z to select or deselect all or any files in the Load menu.
   When you quit out of cin5, if started from a terminal window, the “Session time” will be printed out.
   Proxy switcher has been added and a Proxy “show” button to display when enabled/disabled and
      scalar/non-scalar.  Icon provided by Sam, that is closer to the future design work specifications he is
      working on to come later as time permits (see his forum email of July 30 on “Proxy-buttons”).
   Proxy for single images (such as png, jpeg, tiff, pcm) now works for both scalar and non-scalar.
   Viewer clips with only either the In or Out pointer set will now clip to either the beginning or end.
   Multiple single frame silence insertions are now collapsed into 1 in order to easily undo.
   Updated shortcuts.html to add new shortcuts and a couple of missing ones.
   Changed timeline cursor move while playing to now stop playing when moved.   
   Delete clip thumbnails added to Interface tab of Settings→ Preferences to easily clean up all clips.
   Timeline right mouse click, has 3 new options available:
       Find in Resources - can be used to locate media in the Resources window.
       User title… - has been added for users to change the title there for clarification.
       Show edit – will display in a text box information and the start, stop, and length of the segment.
    Two new “Display” options are available in the Resources window Media and Proxy folder:
       Display packed icons and Display icon list – it will cycle through what is now a total of 4 options
       and there is a shortcut of the letter ‘v’.
4. Bugs/Issues Fixed:
    Libopus build fix;  Arch dependencies for package build fix.
    Batch Render column titles were not being translated.
    Clear default message in status bar (found while loading mp3s).
    Duplicate plugin icons for some strange case is showing on a user computer – changed folder lock to
       attempt to alleviate this issue but it turned out to be a different problem.  A second change to lock
       mechanism for plugin loading to avoid potential duplicates.  Left mods in because clearer anyway.
    Memory leak in lv2 code has been fixed.  Valgrind caught this.
    UnNest clip bug where unnest after a proxy reversal was not working has been fixed.
    Speed slider bar SEGV in Arch is now guarded against.
    Lock in 1 place has been replaced by Condition instead.
    If the LV2 gui enable was not set, the gui button was still ghosted and should not have been so fixed.
    When format in the proxy was unset (just blank), a dummy proxy was created.  This is corrected.
    Rewrote some “locale” startup to fix issues that occurred in FreeBSD but are linux compatible. 
    Time code clear in Viewer when EDL is cleared upon using proxy.
    Added ffmpeg default format as mp4 so that if user does not choose another, it will still work.
    Race condition in Close Mixers when using Perpetual Session has been fixed.
    A tweak/fix in Layer 3 of libzmpeg3.

http://freedesktop.org/


    Removed Alt-x and Alt-z shortcuts which were in error.
   

5.1  Release Notes for changes from 06/01/2018 to 06/30/2018 for these builds

1.  JPEG updated to 2.3.0 because had not been updated for awhile (Andrew R recommendation) and
         updated libx265 from 2.7 to 2.8.
     LV2 hook updated to work for x42 plugins (BIG help through use of Avlinux iso of Glen’s).  Now
        working are Calf, X42, Invada, Infamous, OpenAV, LSP,  Guitarx with “glitzy” gui.  Also working
        with the simplistic gui are C*, MDA (drobilla), Ladspa, DJ, and MIDI.
     Unbundled builds for Arch, Debian, RPM – verified for arch, ubuntu 18, and leap 15.
     Dcraw for raw camera output has been updated with credit to the author, Dave Coffin.  Support for
        new cameras includes 10 Canon, 8 Fuji, 4 Nikon, 3 Olympus, 3 Pentax, 11 Panasonic, 4 Sony.
2.  Usability Improvements:
     Sam has provided a few more ffmpeg plugin icons (thanks!)
     Faster buffer refresh rate for lv2 plugins to make them appear smoother.
     Default transition setting and usage has been changed to work differently (Beghetto suggestion).
     Added to load filter, MP4 next to mp4 and JPG to jpg and short message “Specify filter” (Sam).
     In the Viewer when using overwrite or splice only one of the In/Out pointers is required, other goes
        to the end (Beghetto suggestion).
     A beep sound was added to notify user when proxy step is complete since it can be slow (Sam).
     Igor Ubuntu provided the following suggestions and improvements:
        Shortcuts.html, as used from the Shell Cmds, has had many corrections added and cleaned up.
        The html ShellCmds script has been modified to bring up a specific language version when that
            default language is set in the browser if a file with the translations is available.  Now Russian is
            available and any other language translations are welcome.  This is a nice suggested feature and
            hopefully can be expanded in the future to include shortcuts.html translations. 
        Updated ru.po translation file for Russian translations making it a lot easier for them to use!          
3.  Bugs/Issues Fixed:
     Proxy with multiple cameras was not working correctly but now there is at least 1 way to be able to
         use proxied files with Open Mixers (Igor Beghetto first reported).
     Build script mods have been added to include problems found while attempting work on FreeBSD
         (Yuri emails).  Also fixes for option to not build LV2, add back 10-bit option and other cleanup.
     Reverted to default Pixels in Render video wrench to be the first choice (usually yuv420p) instead
         of available highest quality because it is most common.
     Fixed unproxied clip in viewer problem (Beghetto reported).
     Reworked a format option to switch from 12 bit to 10 bit.
     For Arch, added dependency of libdv in the build script (Andrea email).
     Zoom plugin vframe height uninitialized fix (KharAzar).
     Missing audio when use double click proxy to viewer is now fixed (Beghetto).
     There is now an error message if user attempts to create a nested proxy clip.
     Bug in Apply for Playback A/B has been fixed (Sam reported).
     Batch render save jobs lock problem is no longer an issue.
     Append to Project caused a crash due to earlier mods which has been corrected.
     Nested EDL proxy fix.
     
5.1  Release Notes for changes from 05/01/2018 to 05/31/2018 for these builds



1. Calf LV2 Audio plugins (about 45 of them) have been hooked in using a simplified text gui or a
    glitzy supplied ui from the lv2 plugin programmer.  Other LV2 plugins may or may not work also.
    IMPORTANT - the lv2 plugins are not included with Cinelerra but rather must be installed by the
    user on their own computer – besides Calf Studio Plugins, you may also have to install lilv and GTK.
    If installed the plugins will be displayed in the Resources Audio Effects window as long as Visibility
    has “lv2” checked.  For the first time, you may have to remove $HOME/Cinelerra_plugins to get the
    plugins loaded and there is a new Settings->Preferences flag to automatically start the lv2 gui along
    with the standard simplified ui.  More information in Features5.pdf.
2. Ubuntu 18 build has been added and ub17 will no longer be updated.  Leap/Suse 15 also has been
    added to eventually replace version 14.  Other distros have been updated to include Debian, Mint 18,
    Arch, Fedora...  Thanks to users who pointed out new versions and provided links to new ISOs.
3. Usability Improvements:
    Additional ffmpeg icons supplied by Sam for the new 4.0 plugins were added in (thanks!)
    Ffmpeg plugins now have a slider bar and pot dial for more easily changing numerical values for 
       highlighted parameters.  Non-numerics still require typing of the value and pressing Apply button
       (idea originated from a recommendation by WPFilmaker to make these plugins more usable).
4. Bugs/Issues Fixed:
    OpenCV lib path fix for Mint 17 and Ubuntu 14 32/64-bit.
    Bug found after installing ubuntu 18 for audio waveform background.
    Ladspa code has been cleaned up some.
    Bluray media shell job has had the default buffer size of 2048 hard coded as default.
    An automatic workaround for elision error problem on intel computers resolved with rpath.
    An uninitialized defaults in using the Render Farm which caused a crash on Leap 15 is now fixed.
    

5.1  Release Notes for changes from 04/01/2018 to 04/30/2018 for these builds

0. REMINDER - Undo has a limitation of 250.
1. Ffmpeg has been updated to version 4.0 and there are 9 new working plugins (irclog notification).
2. OpenCV library has been upgraded.  This is an optional feature for some and is already built into the
       64-bit tars but not the pkgs.  However, for pkgs you can grab the tarball for your distro, extract the
       plugins and add them in.  See Features5.pdf 37.14.2 for detailed instructions.
    Additional Stylize OpenCV plugin added as an option which takes the video and varies it in ways to
       make it cartoon-like, edge-preserve, pencil-sketch, detail-enhanced, or stylized.  There is also a
       new PuzzleObj plugin.
   Findobject OpenCV plugin has some useful enhancements and improvements; drag boxes, a third
      column for the replacement object, new checkboxes of reset, draw match, aspect, translate, rotate,
      scale, replace dx/dy, draw replace border, 5 modes, and thicker lines.
   OpenCV fixes include fixing Object blend amount in findobject; removing libipp which was not
       debuggable but could cause a Segv; and fixing the clean/make.
3. Libx265 has been upgraded to 2.7 (irclog notification).
4. Usability Improvements:
    Shortcuts in the Compositor have been added which use F1-F12 keys instead of the mouse and the
       html documentation in Shell Scripts updated (Sam request).  Added ‘b’ for load backup shortcut.
    A Drag Widget checkbox has been created which replaces the drag box that was already in the Title
      plugin.  This will make it easy to add drag boxes in the future for other things.
    Load filter has been added for png, jpg, gif, tiff and webm added to mkv (webm is subset of mkv).
    Reworked plugin Visibility table to only ffmpeg, ladspa, video, audio, and opencv.



    The Ruler in the Compositor window now has a Deltas field for dx and dy.
    New Project menu has had the addition of file path and project name added for future use.   
5. Bugs/Issues fixed:
    Memory leak in Set Format has been fixed; some uninitialized variables are now initialized.
    Fixed undo bug when nested clips are involved (Sam reported).
    Wheel usage for redraws on the timeline (and probably other areas) has been fixed (Sam email).
    Audio/Video Transitions were missed when switched to saving all in english but now fixed (Olaf).
    Plugin Autos in Show Overlays renamed to Plugin Keyframes to make it more intuitive.
    SVG via Inkscape had 2 problems with showing and rendering the results but now fixed (Olaf note).
    Fixed problem of Drag incorrectly consuming an event in the compositor window.
    Problem of 250 undo limitation caused memory munge (found by preobraz).
    Shmmni/shmmax had to be changed to not make the numbers smaller if already larger.
    Title drop shadow smoothing fixed on fraction boundaries.
    Wide characters in the Ruler in the compositor window have been corrected.
    Auto play in Viewer for audio now replays when reaches the end.  This occurred in at least Leap.
    Small code rework and other very minor bugs have been fixed as encountered.
    

5.1  Release Notes for changes from 03/01/2018 to 03/31/2018 for these builds

1. CAUTION – undo compression code has been rewritten because it was not working.  This affects
    everything so be sure to keep backups until you are comfortable.
2. Proxy files now have associated Audio when in the Proxy folder.
    They also now will have an index built for better seeking results (Sam request).
3. Ffmpeg has been updated to 3.4.2; libvpx has been upgraded to 1.7.0 (email deim31).
4. Perpetual Session and a supplementary backup have been added (see Features5.pdf for more info).
5. Speed automation will now update the track duration on the timebar (Sam request).
6. Usability Improvements:
    Change to the Title effect overlay for better aesthetics by removing the grey colored shadows
       surrounding letters caused by blending.  Now blends with background color (email from Ashley).
    Viewer has 4 additional options which selects the entire media piece instead of just between In/Out
       when you add the Shift key to overwrite, splice, copy and clip buttons or shortcuts (Sam email).
    Open assets/clips in Viewer en masse.
    Compositor refresh on forward selection as was already being done on backward selection (Andrew).
    Locking tracks in the patchbay now includes a different colored track title background to better
       indicate that the track is locked and no changes will take affect (partial suggestion of Dorfman).
    Paste Silence will now paste a single frame after the hairline cursor when nothing is selected (Sam).
    Additional DeScratch plugin adapted from Fisick to remove vertical lines from film + Sam logo.
    You can now Load files from the Resource window using the popup menu or the letter “o” (Olaf).
    Smooth option added for Title plugin to add/remove shadow for use with Chroma Key (irclog note).
        Users that have libxft font thread issues may have to reload plugins by deleting Cinelerra_plugins.
    SVG with Inkscape has been rewritten to not use a shell command to accommodate other languages
      and blanks/shell characters (Olaf and irclog).
    Updated the included copy of Features5.pdf with TOC hyperlinks included.
7. Bugs/Issues fixed:
    Clear YUV vframe for initialization purposes.
    Paste to timeline from Viewer Copy was not functional, but has been fixed (Igor email).
    Small bug fixes – memory leak in proxy; index bug; static interface declaration fix.



    Proxy issues resulted in cleanup of tracking and options with the addition of a proxy specific popup.
    Fixed undo/redo deadlock; fixed stale pointer in cached image that caused a segv (Phyllis found).
    Rework nested edls and mixers; fixed EDL copy that affected clips.
    A 4 pixel border with KDE Plasma, creates anomaly on pulldowns but has now been fixed (Sam).
    AgingTV plugin has had the missing parameters of Scratches, Pits, Grain, and Dust now accessible.
    The "Info" for plugin short one line description is now working for languages other than english.
    Setting BC_FONT_SCALE to larger than 1, causes some non-movable windows to have some
       options cut off and not usable, but now at least the plugin windows are larger (irclog note).
    Automation Type is automatically switched to display the in use type.
    Segv in SVG with Inkscape plugin due to file load window still hanging around is now fixed.

5.1  Release Notes for changes from 02/01/2018 to 02/28/2018 for these builds

1. Repeat Play (Infinity Loop) in Viewer/Compositor/Timeline with Ctrl+Shift+transport button
     (several requests in ML over time).
2. Mouse action in Viewer/Compositor can be toggled on/off via the arrow in the editpanel on the
    right hand side of the other buttons.  Default is off, but you will want to turn it on at least temporarily
    to easily review your video before a final render.  Note that some 3 button mice do not accommodate
    a middle click for reverse but you can find out by testing with the command xev.
       left click=forward play; middle click=reverse play; middle wheel=single frame forward or back
3. The first few seconds of the Audio can be played in the Resources window by double clicking the
     icon as long as “draw vicons” to the right of the word “Visibility” is enabled.  In addition, the Video
     icons have had the audio included in the loop playback (Sam email).
4. There are 7 third-party programs that have been updated; these include exr, fft, ilm, x264, x265,  tiff,
     and lame.  Impact on builds has had to be remedied for some distros using an older version of nasm.
     Plus 265 has had 10-bit incorporated into the code so a special 10-bit version is no longer needed. 
5.  New behavior is exhibited in the main menu pulldowns, the Preferences menu, and the Resources
        window which now have persistence until selection or move out of the window (Kent Dorfman).
6.  Nested Assets/Edls have been added which automatically render and allow for precedence changes.
7. Usability Improvements:
    Viewer window improvements to include:
       Viewer window not clearing when load new file or close source, etc, now working (Sam/Igor).
       Omission of EDL for Viewer being reloaded is corrected (Igor).
       An image of the audio waveform that is currently in the Viewer window is displayed.  It is the first
         few samples similar to that shown in the thumbnail in the Resources window (Sam request).
       Vwindow locks have been reworked.
       Left mouse click in Viewer if at end of play, will start the play over from the beginning (Sam).
       Glitch with the position indicator after pressing home or end in Viewer has been fixed (Sam).
    Append to project capability added to Tracks pulldown to add another set of tracks (Glen).
    Multiple asset info is now available in the Resources window to bring up all highlighted at once.
    Shortcut for In/Out pointers is now also < and > besides the [ and ].
    The shortcuts.html file has had 30 additional lines added to document some missed shortcuts.
    File size in File→Load is displayed with 3 significant digits in  bytes, K, M, G, T, P instead of just
       bytes.  There are currently 4 options to choose from by clicking the left most button on top to the
       left of the “Up a directory” icon.
    An additional option file, y4m, for use with yuv4mpegpipe has been added.
    F_lut3d plugin is now enabled for usage with cube input files (irclog request).
    Ffmpeg plugin default operation is slightly different.  If the value is unspecified, it uses default.  If



       you specify the default, the value becomes unspecified (nothing gets passed to ffmpeg).
    Alternate shortcuts using comma and period have been added for ease of use with different
       keyboards (Sam noted problem).
    Clips in the Resources window now have a png thumbnail for identification purposes.
8. Bugs/Issues fixed:
   Snapshot/Grabshot no longer hang in empty Resources window (Igor).
   Shader program memory leak has been fixed.
   The 40 build color transfer function compiling has been streamlined to speed up compiles.
   Undo glitch when In or Out pointer used on the timeline has been fixed (Glen/Igor).
   Subtitle track problem not showing the script is corrected.
   Memory leaks in Recording and other routines have been fixed.
   General code cleanup always in progress – mostly to remove extraneous lines.
   Scroll Resources window fixed on the second load/scroll (Sam email).
   Update compositor Edit Mask info window to include another help line.
   Translation for plugins that show in the Attach Effect screen have been re-enabled.
   Mistake in drop target fixed and a freeze in the Viewer window for a clip fixed (Sam found).
   Null attach effect SEGV problem is corrected (Sam noted).
   Recover lost auto is now fixed + clip note fix for carriage return.
  

5.1  Release Notes for changes from 01/01/2018 to 01/31/2018 for these builds

1. Plugin names saved in the EDL are now retained in the original english language.  Previously
    saved XML files will automatically be translated back and when saved again, will be saved in
    english (multiple requests – Andrey, Igor, Sam).
2. Shell Script, RenderMux, added to copy via ffmpeg all of the created render files.  This required
    the addition of a new environment variable, CIN_RENDER, to contain render filename (Andrey).
3. Quality value has been added to Audio for rendering.  Default works as before but now different
    codecs will handle a quality audio request in its own setup.  For example, vorbis allows audio quality
    to vary between 0-10 which results in higher bitrate/larger filesize as # is increased (sullivan irclog). 
4. 2 Pass option added for VP9/Webm and other codecs allowing for 2 passes can use also.  There are
    2 pre-rolled options files under the webm format to easily set up 2 passes.  These were based on the
    work of Frederic Roenitz’s 1280x720 webm option file.  Had to add cin_pixs_fmt=gbrp specifically
    for libvpx-vp9 which was not choosing a good default color model.  Who invented gbrp anyway??
5. File Formats added of raw video (yuv and rgb), raw audio pcm, and ppm / ppm sequence to
    rendering choices  (ppm image data is stored in byte format, one byte per color component (r,g,b) in
    raw format).  Addition was necessitated by the need to carefully analyze and compare what goes into
    cinelerra with its output.  Ppm was also added to the snapshot/grabshot as an output format.
6. Resources Media now has audio waveform icons to distinguish audio media (Sam email).

7. Usability Improvements:
    Render Farm changes and fixes (thanks to Andrey for communicating issues for improvement):
       Rework render farm strategy to allow for more multiple cpu usage.
       Created methodology for using Render Farm in the creation of dvd/bd media.
       Added multiple port addition or deletion by using a range or highlighting the ports.
       Fixed bug in Render Farm nodes listbox gui.
       Port number tumbler box was being incorrectly incremented by 1 when changing hostname.
       Fileogg which allows for packaging render farm sections into a single file has been updated to get



          it back in synch with current program code.  Otherwise it would SEGV.  Also, when the
          rendered sections are mux-ed together, the original files are no longer deleted.  Despite the fact
          that this requires twice as much disk space, it allows for “fixing” any issues between sections.
       Batch Render menus have additional checkbox and fields of “labeled” and “farmed” added.
       Show Progress for render farm in gui has been added.
       Setting for watchdog timer has been added due to insufficient 15 second timer for smaller clients.
       Moved location of Reset Rates over by the Nodes listbox that display the framerates.
    Audio channel position rework.  “A confusing сhannels_positions in SetFormat_window and in
       theme-related audio panning boxes in the track patchbay have been changed from -

       OLD       NEW
       2:Front Right  1:Front Left    3:Center                    1: Front Left   3:Center 2:Front Right
       4: LFE            6: Rear Right  5: Rear Left               5: Rear Left    4: LFE   6: Rear Right”
  
   The ffmpeg file formats in render are now sorted alphabetically.
   Piped files can now be set up and used in rendering.  For usage, refer to Features5.pdf (irclog note).
   Asset codec format, Pixels for video and Samples for audio (stsbqm irc), now show in Render menus.
    
8. Bugs/Issues fixed:
    Fix segv for opengl background rendering (noted when working on Glen issues).
    Align and merge track error has been fixed.
    Rework drop_edit, plugin_position to align drop position on the tracks.
    Bug fixed where the TZ-UTC time was being used instead of the correct localtime.
    Try FFMpeg first/last was being incorrectly reset in some cases inwhen Settings→Preferences
      changed (bug reported by Igor in 8/2017).
    Shell scripts editing menu had minor change of the menu where it was squeezed for space.
    At least 3 deadlock possibilities in batch render with render farm have been fixed as related to a 
       Shift-G hangup in conjunction with Preferences (mail from Lukas).
    Trace thread fix; grab event performance change for Title/Crikey plugins.
    Default options file for mp4 switched from h265 to h264.
    The 5.1→2 mapping was not working correctly but has now been fixed (abbrechen irclog).
    Minor cleanup in various routines and an ffmpeg fix.
    The audio meters in the patchbay had a bug that was introduced at some point in time with a merge,
       a buffer leak was fixed, and a memory leak was fixed.
    Cleanup in “show error”; disable opengl with ffmpeg plugins because it isn’t allowed.
    Scale ratio now allows for opengl usage.  Pcm probe fixes went in.
    Faststart option file has been modified to ensure that yuv pixel format is used due to high profile.
    Vwindow viewer is cleared when a new piece of media is loaded and if you click the left mouse
       button it will automatically start and stop play (Sam mentioned).

5.1  Release Notes for changes from 12/01/2017 to 12/31/2017 for these builds

1.  HistEq plugin added which provides Histogram Equalization (concept same as Gimp/Inkscape/Xv).
2.  Ffmpeg upgraded from 3.3.4 to 3.4.1 to keep contemporary and get latest patches (Andrew notes).
3.  Libopus is now enabled as part of the ffmpeg build so as to provide high quality audio that is freely
    available with no license restrictions, i.e. can be used in sold products and commercially (Frederic).
4. Grabshot is a new option in the Media folder - right click on empty space to see this menu item.
    Also note that snapshot has been moved from the edit popup to this asset popup because that is



    where it should have been in the first place (make sure Wolfgang Brunner knows about the change 
    since he initially requested snapshot feature).
5. Many, many more Cinfinity style icons from Sam (credit Creative Commons):
    Cinfinity2 – square cinfinity icons – you may prefer these because even though they are the same
        size, the relevant part goes to the corner so you see more of the picture.
    Transition icons are now modernized too – Very Nice!
    Additional ffmpeg plugin icons as a result of ffmpeg upgrade (about 14 more).
6. There is now an ffmpeg format file type of youtube for use by new or less experienced users so
     they can at least pick the default and not be overwhelmed.  The default choice is totally based on
     Frederic’s work-of-art vp9/webm option files.  All 6 options were tested and uploaded/played and
     even though the default extension is now youtube instead of webm/mp4, youtube accepts it just fine.

7. Usability Improvements:
    Color Range / Color Space  / YUV related mods that have been applied:
       The late November mods for YUV had a few bugs that were fixed early on (Pierre found).
       OpenGL implementation rewritten to better handle color space and color range options.
       BT2020 color space/range option added (Settings→Preferences Appearance tab) for UHD.
       Changed ffmpeg default file color model for consistency purposes.
       Some related make-shader rework has been done and frame parameters in cache file.
       Timefront and YUV plugin color issues have been repaired.
       Dot product OpenGl problem fixed – affecting Threshold, ChromaKey, and Difference Key.
       Updated “info” for the newly added 14 ffmpeg plugins.
    Additional ffmpeg option files for h264/h265 2-pass encoding are now available from the
       interactive Render so that can be used instead of Batch Render (although Batch Render has the big
       advantage of saving the entire setup for running it multiple times).
    Default Settings→Performance Cache size increased from 16MB to 256MB (noticed while working
       on email of jEsuSdaA 8).
    There are a few additional option files for ffmpeg as submitted/needed by users (Frederic/Andrew).
    Relative path names, as well as the full path, will now work in the loading of file list sequences.  
    Added date/time/sort to Resources MediaProxy folders and time to File→Load (Frederic request).

8. Bugs/Issues fixed:
    Bug in Mixer Viewer pulldown segv when no video loaded has been fixed (Andre noted).
    ChromaKeyHSV and Color Balance were not working correctly with OpenGL but now fixed.
    Difference Key and Lens plugins bugs have been fixed.
    Added number of file descriptors and amount of memory used to the dmp file.
    Picon data fixup to correct wrong png files.  Fixed icon image lookup bug.
    Histogram plugin bug fix put in.
    General cleanup in several areas to include: rebuild index, vicon read-in, filebase, etc.
    Many memory leaks in the code have been fixed.
    Average frame rate is now in place so that lossless vpx will maintain current frame rate.
    Asset update mtime for proxy folder in an attempt to ensure all icons show (Sam email).
    Removed esoteric “not on table” error message that was written to terminal window.
    Fixed bug in bcrecentlist.C (Yuri found).
    The colormodel in Recording screencapture was yuv420 and was low resolution, so changed to
       rgb888.  (Andrew discovered and reported this problem).
     Some issues with mixer undo were fixed (Andre noted undo keyframe took the mixers down).



5.1  Release Notes for changes from 11/01/2017 to 11/30/2017 for these builds

1. Mixer Viewer for multiple media or multiple cameras has been added (Frederic request).
2. Sam’s ladspa plugin icons part 2, 3, 4 are now in and are complete (credit Creative Commons).
3. Blade Cut and Hard Edges new feature added.  Simple to use! Hard to code!!
4. Many new additional opts video/audio render files of type vp8/9 for webm and mkv + theora  and
    ffmpeg opus, libopus, flac,+ vorbis along with documentation provided by Frederic (Thanks!)
5. Upgraded all of the O/S distros on the build computers.  This is being noted here in case users with a
    distro that has not been upgraded has an issue with the newer builds of Cinelerra.
6. Usability Improvements:
    Wrote a small program that can easily change the background specific color for icons, and used to
       create theme-related coloring for the folder icons.
    Changed Keyframe Reticle line (Always option) from green to blue for better audio visibility (Sam).
    Reset button added to plugins chromakey, chromakeyhsv, and gradient (Sam suggestion).
    Additional resolutions and a 3rd column description have been added for ease of use in the
       Settings->Format and File→New resolution choice (Frederic suggested/provided the information).
    Factory preset for rule_of_3rds added for f_drawgrid plugin use in compositor with camera (Sam).
    Hotkeys/buttons (see shortcuts.html for hotkey designation):
        Keyframe position hotkey for going to the next/previous keyframe (Igor suggestion).
        Hotkey for deleting the set of In/Out pointers (Igor suggestion).
        Shift + the Delete button in the Tool Info in Compositor will delete the entire mask (Igor note).   
7. Bugs/Issues fixed:
    The wrong clip icon was showing up due to picon strategy change (Sam discovered).
    Added a way to get more information when running as a user in order to debug using ptrace_scope
      and also displaying memory size (need for video developer).
    Keyframes not being displayed for mask in realtime on track now fixed (Igor found).
    Problem with default mask keyframe at beginning of track now correctly being handled (Igor note).
    Resources window not getting updated when cut or perform other operations that affect labels, etc.
    Changes to how OpenGL closes window have been made.
    Shmmni sysctl.d bump for more shared memory usage for debian-type distros (video developer).
    Option to disable build of libsdl (Dominque with Gentoo build).
    Undo cache reset bug which caused failure of correct undo’s and redo’s has been fixed.
    Theme images access rework to provide some speedup.
    Fix mask vframe setup and add unshared vframe constructor.  Problem due to shared memory
       resource.
    Rework of deglitch, stop playback, and optimization code.
    Fixed memory leak in masks.
    Some positioning rounding changes.
    A bug fix in Alt-f usage for auto-fit has been fixed and slight rework in some default settings.
    Opus webm usage caused SEGV when ffmpeg channels was greater than 2 and has been fixed.
    When libopus is installed on the O/S, cinelerra has been modified to include this in ffmpeg.  Note
        that the most used operating systems of debian-style, like ubuntu/mint/debian don’t by default.
    Rewrote ydiff to accommodate threads and remove need for GTK+ (since gtk not thread safe).
    The next label select operation was not working right but has been corrected.
    Single frame playback and plugin additions in some cases changed from yuv to rgb causing a slight,
        but confusing change in the compositor.  This is now fixed (Pierre reported).
    The above led to major changes to allow for color space and color range choices selection along with 
        improved dialed in output.
    RGBA_FLOATP color model transfers to non-alpha models caused a segv which is now corrected.



  
5.1  Release Notes for changes from 10/01/2017 to 10/31/2017 for these builds

1. Alternative to keypad for play/transport keys added for computers without a numpad.  Refer to the
      shortcuts.html associated with the “shell cmds” button to see equivalences (Quinton).
2. Snap/Cut editing and snap while dragging stickiness (Quinton feature request).
3. New icons for the folders, audio ffmpeg, and Ladspa  in the Resources window and some more
    changed icons from previous changes provided by Sam (credit Creative Commons).
4. Added HV7 mods in a continuing attempt to get all Cinelerra mods merged into 1 place:
    Speedup for large format files, for example 4K, added which uses a direct access method. Because of
        this potential speedup for several files, X11 is now the default driver.  Also, when X11 is picked, a
        checkbox is available to turn on/off direct rendering –  "use direct X11 render if possible".
    Option for including regular or large sized mouse while recording + a boundary box to easily frame
       the area for a screencapture.
    Presets and Factory Presets are now combined with the Preset Keyframe Parameters allowing you
      to choose, apply, delete, save, edit your own Presets which are saved in .bcast5/Cinelerra_presets.
      Default factory presets have been added for Compressor, Lens, Spectrogram, Downsample, Scale,
      MotionHV, Reverb, Interpolate Video, Chroma key (HSV), Histogram, EQ parametric, ReframeRT,
      and Sphere Cam.  A Presets button has been added to the plugin bar (as requested by Frederic).
    Max color for the eyedropper, when checked, sets color to the max value within the chosen area.
    Clock in left hand corner of main track canvas modified to be characters instead of line segments. 
    It is now possible to create different theme background colors for the clock in case of color conflicts.
    Assets allow for multiple windows. For example, you can bring up in the Resources windows, 
       multiple asset info windows on different media at the same time.
   Textboxes have right mouse click popup for “cut, copy, paste” options.
   Plugin changes:
      Sphere camera new effect has been added.
      MotionHV now uses cache; major changes to Reverb; and changed Timestretch plugin.
      Interpolate Pixels changed to Interpolate Bayer using the Bayer algorithm for interpolation.
    Some keyframe gui changes went in.
    The “asynchronous” option (under “play every frame”) in Settings→Preferences has been deleted
       because ineffective.
    Deglitch for audio was added for some specific problem where there were little fragmented audio
        edits that didn't line up with the video.
5. Xen for automating builds for multiple distros has been configured into the Cin5 build systems.
6. A new Search function in the Resources window & Attach Effect option now available (Igor/Sam).
7. Usability Improvements:
    Upgraded Russian translation courtesy of Igor.
    Highlighting Inversion Color setting in preferences added to allow for changing selection color. 
       The default is still white of ffffff (requested by Quinton).
    Set Input Focus when window entered also a new setting in preferences to automatically focus.
    The ffmpeg F_nlmeans plugin, commonly used to denoise VHS tapes, has had a thread count added
        so that more than 1 cpu can be utilized to speed it up some (Thomas email).
    A Sort is now available in the folders area of the Resources window (more comfortable for Igor).
    Snapshot capability for a single frame to save as png, jpg or tif (Wolfgang requested).
    Load files icons updated to include about 60 file types such as avi, png, m2ts, dvd, mkv, h265 and
        so on.  Igor pointed out deficiency and provided another mod to greatly enhance the list.



    Folder code changed to allow for multiple folder icons.
    A new build option of - -with-git-ffmpeg=no  or =a url  allows for building with current ffmpeg from
       its Git repository.
    Tooltip for the Control button on plugins now read “Turn on”/”Turn off” correctly (Frederic noted).
    A problem with a bad system font, necessitated the addition of BC_FONT_DEBUG variable to 
       provide extra informational messages output to the terminal window so that a determination could
       be made as to any potential problems in the Titler.
    Setting  BC_FONT_PATH=:  removes all font paths from inclusion for the Titler except for any then
       included in the font path.
    Setformat and Preferences Theme improvements and new SVGs provided by Igor.
8. Bugs/Issues fixed:
    Proxy editing fixes have been applied to include the following:
       Multiple file loads was hung up due to improper lock on the Progress bar (reported by Sam).
       Allow for usage of more than 1 cpu to speed up proxies.
       Changed Alt-p to Alt-r due to conflict with numpad key alternatives.
       Better translations for “de” language (provided by Sam).
       Fixed problems with the proxy files showing up incorrectly in the Media folder.
   The “User” folder which is not currently being utilized has been temporarily deleted.
   Junky keyframes showing up when drag edit have been commented out until have time to do a full
      and thorough investigation/implementation (Igor pointed out).
   If the “subtitles” file was deleted, cinelerra could crash on next usage.  There is now a guard against
      this happening (Ugin reported problem).
   YUV interpolation for some plugins, like perspective, now has correct background offset subtraction.
   Listbox drag fix is in that prevents disappearing folders when moving them has been fixed (Igor).
   Scroll bar on Compositor not supposed to come up automatically on startup so fixed (Danny noted).
   In Keyframe Parameters, the underline is no longer in the wrong place (Sam reported).
   Removed ff_anoisesrc plugin since it crashes (Sam found).
   When dragging an icon in the Resources window, the arrow was off the icon so fixed (Igor email).
   Dragging an effect from the Resources window was causing a scroll.  Now corrected (Sam email).
   Memory leaks pointed out with the use of Valgrind, have been eliminated.
   MSGQUAL which is used for contextual language translation has been improved for ease of use.
   More language translatable words/phrases have been added.
   Some format geometry choices have been deleted and some framerates have been added.
   An XFT font/Xwindows lock issue was identified which can definitely hang your session if you
      operate multiple simultaneous playbacks, although not a problem in normal use. A patch is 
      included in the thirdparty src directory for you to rebuild the library on your system if desired.
   Plugin client fixed for legal 0 input.  This fixes ff_Sine ffmpeg plugin.  (Sam reported).
   Bug in File→Scan→ Find ChanSearch window resize with disappearing ‘Text’ fixed (Igor).
   Settings→Preferences→Recording, Record driver choice related fixes are in (Igor reported crashes).
   Changed Picon strategy for future ease of use and coherence.
   Empty keyframe edit no longer crashes for plugins such as Aging TV.
   Drag plugin tweaks have been added to attempt to alleviate KDE’s problem with dropping the plugin
      onto the main track canvas.  This was an old unresolved problem  (Sam and Igor analyzed/tested).
   Wide character support to fix several issues, such as Russian language ability to ignore case in the 
      search feature, suggestion box issues, keypress for paste set to 0 and file name loading (Igor found).
   Fixed SEGV occurring in the subtitle text boxes when triple click (Igor reported).

   
5.1  Release Notes for changes from 09/01/2017 to 09/30/2017 for these builds



1. Proxy editing has been added after porting, modifying, and enhancing from HV (Glen/Sam).
    Preliminary testing by Andrew/Igor/Sam/Frederic helped fix bugs and add more features.  
2. There are now 102 new ffmpeg video plugin icons, 2 new plugin icons, and some changed ones
        provided by Sam (credit Creative Common) - professional quality and newly modernized.
3. OpenCV 3 (Computer Vision) is now an optional build in order to use the following plugins:
     3.1 The Find Object plugin using OpenCV3 has been upgraded to work to find an object (nicat45)
     3.2 The Move Object plugin has been added to move an object and stabilize it.
     3.3 The Flow Object plugin retards image motion as shown with optical flow.
     3.4 The Gabor Object plugin creates fractalius-like image effect.
4. A new plugin, Rumbler, has been added that gives dream-like or earthquake-like qualities to video.
5. Rework of Affine and generic Interpolation code addition.  This may have some effect on the
    filescene code, and the plugins: all motion, perspective, lens, radialblur, rotate and interpolatevideo.
6. Version upgrade of ffmpeg to 3.3.4.
7. Usability Improvements:
    A preference new option has been added – Always show next frame in Settings→Preferences→
       Appearance tab that “displaces” forward movement by 1 from the default.  This only affects
       “plays” in the forward direction (Frederic request).
       Gang Speed and Fade Automation was limited on length of time due to mathematical formula so
           changed to direct integrals for floatautos.  Now should be able to handle longer intervals (Fred).
       A retry_limit was too low causing audio speed dropouts so a reset was added (Frederic reported).
       Ladspa plugins were renamed as L_plugin so as to have them grouped together in Resources and
           because there were duplicate names such as Crossfade.
       The Lens plugin now has a reset button and 3 types of Interpolation choices (Sam email).
       Theme menubar has had the green Heroine Warrior logo removed for consistency (sort of Glen).
8. Bugs/Issues fixed:
    Keypad 1&4 with Ctrl, when in/out pointers set was not honoring the in/out.  Now working right.
    Vrender delay/countdown which resulted in a snap effect has been corrected.  It was noticeable as a
        snap effect when playing with in/out pointer set.
    A couple of minor Perspective plugin program fixes that prevent errors.
    Seek in ffmpeg loaded files has been changed to prevent incorrect positioning when go back to zero.
    Another guard against bad ffmpeg audio files.
    Ladspa plugin, Analogue Oscillator, freeze has been fixed caused by zero range pot sigfpe (Sam).
    A couple of Ladspa bug fixes and minor cleanup was done.
    After loading a plugin, the data block parameters were deleted while still in use.  Now fixed.
    The error list was not protected by the lock, resulting in a crash, is now fixed (Ugin reported).
    Titlebars for Cyrillic characters, such as Russian, when switch language to/from english code has
        been changed to use a different method.  There should no longer be “frettings” (Igor/Vevgenich).
    
    
    
5.1  Release Notes for changes from 08/01/2017 to 08/31/2017 for these builds

1. Updated version of H.265 library included.
2. Added Specks and Burst to Video Transitions Shapewipe and reworked Spiral.
3. Usability Improvements:
    Using the keypad 1-6 transport now allows for either adding the audio, such as in
       the case of KP1 and KP4 by using shift-KP1/4, or deleting the audio for KP2,3,5,6 with the Shift.
       (Pierre noted a need for audio with KP1/4 in an email response).



    Added “One Frame” option to Render window to Render Range choices.  In addition, ghosting of
      illegal choices for render range will be in effect, more error messages will be generated such as
      “zero render range” when nothing is selected, and window has been widened (email from Andrew
      stating some problems + Igor’s response caused these fixes/improvements to be generated).
    Modified Render window to have the red checkmark for Render Audio Tracks and Render Video
      Tracks checked if available for the chosen format.  For example if have Music mp3, Video will not
      be checked.
    Modified CriKey plugin to allow for choosing multiple points for chroma key instead of just 1 and
      also removed Search/Search All since no longer needed or already in Chromakey plugin.
    Added showing of Hex color value in composer eyedropper.
    Upgrade of C41 plugin with bug fixes for divide by zero and other problems (see Features5.pdf).
    Added Shell Cmds “shortcuts” html for ease of use and to Features5.pdf.
    Clipboard rework – this was fixed to solve a problem with Ctrl-C/Ctrl-V.
    A CIN_XSYNCH export variable has been added to assist developers in debugging windows.
9. Bugs/Issues fixed:
    Fixed bug that showed up in Titler and CriKey plugins where events were being grabbed across
      windows when they should not have been.
    Added to the COPYING file about licenses, the cinfinity icons from Sam / creativecommons.
    A memory leak when load filters/read frames in use has been diagnosed and alleviated.
    Improper Reticle Keyframes refreshes have been fixed.
    Some resizing in the Render and Preferences Tab area for language translations (Igor notes).
    Default Theme missed translation has been fixed (Sam found).
    Valgrind reports of errors has been addressed.
    For the Copy/Paste file list, made the window resizable to accommodate long file names (Frederic).
    Fixed bug in rewind single frame audio.
    An infinite loop in the audio alsa driver is now gone.
    Fix for lock state on grab windows.
    A case where video up with plugin and show controls, and then load another, turns off controls is
       fixed (Phyllis found).
    Background Rendering problems fixed (discovered/reported by Frederic):
        - removed ffmpeg as an option as only meant for sequence type output
        - using PNG under certain circumstances crashed due to undefined color model
        - switch from non-Alpha to Alpha incorrectly changed the size
        - the format filename was incorrectly having an extension added to the filename
    A build dependency for xorg-server-utils has been removed from the Arch distro because Arch no
       longer uses it (IRC question).
    Refresh frame code has been moved.
    Some cases of the zoom in the Compositor window drifting has been fixed.
    The New project option code has been cleaned up and New now kills/deletes previous project.
    Developer code now prints out memory leakage and new program leaker.C can help find these leaks.
        Using the leaker program, a lot of small leaks were fixed.
    When using the keypad to play and then stop, in the main window the insertion point incorrectly 
       “hopped” one additional frame backwards/forward has now been corrected (Frederic).
    Window Manager problem tweaks to avoid potential errors (discovered via Alain/Debian Stretch).
    Language translation for info.txt for short description of plugins bug fixed.
    When quitting Cinelerra with the Titler, a SEGV occurred sometimes, but now fixed (Phyllis noted).
    Fedora build required small change for the latest version.
    Clear cache for undo/redo editing since it was causing a SEGV.
    The Alt-# (used on a multi-program video) had a range check issue that is now corrected. 



    A SEGV in plugin_set has been fixed.
    

5.1  Release Notes for changes from 07/01/2017 to 07/31/2017 for these builds

1. New plugin icons (picons) are now a choice in Settings->Preferences →Appearance and will be
    saved across sessions.  Credit: Creative Common By https://creativecommons.org/licenses/by/3.0/  
    (Sam).  This currently includes the Video and Audio icons, the transition icons, and a replacement for
    the single ffmpeg audio/video and ladspa icons.  Cinfinity will be the initial and fallback default so if
    you want to switch to the original or Akirad versions, change it in Settings/Preferences/Appearance.
2. Caution: There was a lot of general code cleanup and rework which was tested but could still
    have some issues so be sure to report problems.
3. Additional capability has been added to Copy and Paste clips or a list of files within and across
    multiple instances of Cinelerra.   In the Resources/asset window, popups have some modifications to
    support new capability such as “Copy/Paste file list” for Media, “Copy” & “Delete” for Clips, and
    “Delete” & “Go to” for Labels.
4. The Perspective plugin has had implementation changes made for cubic edges, plus there are now 4
     choices for  methodology, with Cubic looking the smoothest.  There is a zoom bar, red outline
     boundary box, along with additional view and translate capabilities.  Also, the Reset button has been
     moved so that longer words in language translations are not cutoff (Sam feedback).  See Features5.
5.  A right click on a plugin in the Resources window has a new Info choice that will provide a short
     description of the plugin (currently all video and audio plugins & transitions are available.  This
     uses contributed work from WPfilmmaker for the ffmpeg audio and video plugins he had outlined in
     Features5.pdf (Peter suggestion).
6. LADSPA library upgrade to v0.4.17 which contains bug fixes (thanks to plugin.org.uk).
7. Added Leap 42.3 to the build machine so will be building a package for that also (Terje noted).
8. Usability Improvements:
    In the Resources Window, the “right click” for Info now will replace the previous “Asset Info”
       window if one is already up.  This applies to Media and Clips (Peter suggestion).
    FF tooltip has been reworded to make the meaning clearer for users (Frederic suggested).
    The Shell Cmds button also has a default “Setting Shell Commands” for easy access to usage
        (Frederic recommended clarification).
    The “Rendering took” time in the lower left corner of the main track canvas is now left up until
         certain status changes or until a File→Load (Frederic pointed out the need for this).
    Removed Reel Name, Reel Number, Time Code Start from Asset Info in Resources & Preferences.
    A few environment variables were set up for easier usage, such as CIN_BROWSER.  See Features5.
    OpenEXR is now configurable in the “configure” script; use with or without EXR.
    A “status update” has been added to the statusbar message area for the load status.
    Stretchable scrollbars have been added.
    More Russian translations available (credit to Igor for contribution).
    Picon directory strategy has been modified to accommodate new cinfinity and other picons.  In doing
       so, it is now possible to create your own picon directory in the same path as picon_cinfinity, etc.
       with your own versions of icons and this can be selected in Settings->Preferences->Appearance.
    The Settings→Preferences Interface tab was too long in the Y direction such that users with a small
       laptop screen could not make changes and then click OK to have them take effect.  So that tab was
       split into 2 tabs of Interface and Appearance with other minor rearrangements.
9. Bugs/Issues fixed:

https://creativecommons.org/licenses/by/3.0/


    Background Rendering toggle on/off not taking effect has been fixed (Sam reported).
    CriKey new plugin was crashing when used via the right click Show, but now OK (WP noted).
    Gradient plugin dials are no longer disappearing when switch from/to radial/linear (Sam reported).
    In Rendering/Video Wrench, prevent button 2 Tumbler updates when disabled (Sam discovered).
    Affine routine has been reworked (used by Perspective, Motion51, and a few other operations).
    Right Click in the Resources Window, now brings up the additional option of “Display Icons”
       which had mistakenly been commented out (Peter noted).
    A “race” condition in the Compositor for clipping has been alleviated (Sam reported).
    Clips shown in the Resources window no longer wipe out some information.  Also, the default
       comments have been modified so that now you will see the name of the window clip came from,
       the date and timestamp and length on 1 line and the EDL it came from if available (Peter reported).
    Background rendering Shift-G lock up/freeze is no longer a problem. (Sam reported).
    Audio waveform disappears after clipping on the main timeline has been fixed (noted by Sam).
    Missing “\” in bld_prepare.sh has been added back in (Frederic provided feedback).
    At least one instance of an empty title/comment of “Hello World” for a clip has been replaced with
       information (Peter noted).  Could not find any more reproducible cases.
    The Resources window “rebuild index” for certain non-ffmpeg files is now getting done right.
    An embedded “CR – carriage return” in a file name or pasted in, is now being handled.
    A SEGV situation in mwindow has been fixed; bug was undetected for a long time.
    Label edit deadlock is no longer a problem (Frederic reported after #2 above changes).
    Info detail in Resource window SEGV has been fixed (Phyllis found).
    Problem with seek-less stream when using ffmpeg required a mod to ffmpeg (Doug reported).
    At least 1 occurrence of mistaken clips/unwanted comments when in “resources only” mode fixed.
    A problem with Chinese characters in the Titler led to discovery of a bug whereby different
       algorithms were being used for the text in 2 different places.  This has been fixed and rework of the
       text drawing was done (WP reported).
    Compressor audio plugin no longer crashes when attempting to set the Point field (Phyllis found).
    Error message in status bar only flashed on the screen and not long enough to read is correct now.
    Video Transitions were not correct when using OpenGL – it flashed black and was not smooth.
    Added ShapeWipe transition choice of Spiral.
    Updated Features5.pdf was included in this release.



5.1  Release Notes for changes from 06/01/2017 to 06/30/2017 for these builds

1. Raw Image camera file (CR2) fixes:
      Non-operational checkboxes for “Interpolate/White balance CR2 images are now functional.  This
          had caused too dark images (reported by Andrew Randrianasulu).
      Reworked dcraw.c to be “multi-threaded” to take advantage of multiple cpu-s computers; this
         has made use of this program faster for loading/rendering raw images BUT uses more memory.
      Misplaced Lock was causing SEGV, but the lock was moved to prevent problems.
      Fixed SEGV caused by raw tiff-pipe files incorrectly handled by Tifflib.
2. FFMPEG library upgraded to 3.3.2 (previously was 3.3).
3. “Faststart” option added in MP4 container for rendering with user-specific parameters to generate 
      a small output file of reasonable quality.  The previous option file for the MOV container has been
      renamed (contribution of the parameters provided by deim31 in an email).
4. CriKey plugin added which is sort of equivalent to the bucket fill of Gimp.  The CriKey icon is a
       kangaroo.  CriKey does edgedetect, chroma key, and interpolation.  Will be documented soon.
5.  An X,Y coordinate has been added to the Eyedropper in the Compositor window so that you will
        know where the point you picked is to easily find it when you zoom in.
6. Bugs/Issues fixed:
    Utilities for mpeg have had to be renamed as zmpeg to avoid conflict.
    Zoom Slider in the compositor window now correctly handles window resizing.
    Error handler bug fixed when non-existent directory used as destination for render output.
    X11 device rework/cleanup.
    Improved probe for libmjpeg to reject unknown color models.  They will then be handled by ffmpeg.
    Sound file fixes for unknown format – sets default asset.
    Added flush to prevent race which caused Xwindow errors.
    Vframe copy constructor was not correctly copying planar color model vframes.  Now fixed.
    Upgraded vframe write_png to handle all color models.
    Audio configuration now real-time tracks media configuration during playback.
    If “activate” fails, function is disabled in playback and scan for ffmpeg.
    Fixes to prevent SEGV in ffmpeg audio has been added.
    Edgedetect plugin has been reworked to avoid unnecessary steps + cleanup.
    Text Tumbler Tweak, the tumbler used to change the numerical values was not initialized right away.
    A workaround for the incorrect reporting of “fps” for frames per second while rendering using
       ffmpeg has been applied (reported by Frederic Roenitz).
    

5.1  Release Notes for changes from 05/01/2017 to 05/30/2017 for these builds

1. Many of the distros on the “build machine” have been upgraded to latest versions for the distro.
2. Mp4/ffmpeg format “movflags=+faststart” file is now available which puts the meta-data in the
    beginning of the file to save time and errors in loading the Mov type file.  (Request of deim31).
3. Builds for Mint 17.3 have been put back as part of the builds due to usage.
4. For help in building slackware version from the Git repository, a SlackBuild was checked in.
5. More Title plugin improvements: (mostly as requested by WP)
    The text character limit of 1023 has been increased to 3071 (counted as 8-bit characters).  This
        affects any “message” buffers.
    Number of characters used and buffer size remaining now are output/updated above the text input.
    A horizontal scroll bar was added to the title plugin for ease of use.  Both the horizontal and the



        vertical scroll bars only appear when there are more lines or characters than can be seen.
6. Updated dcraw – Dave Coffin’s open-source computer program, which reads many raw-image
    formats typically produced by the almost 700 high-end digital cameras Dave listed on his website,
    has been merged with existing mods.  Coffin added many more newer cameras in his 5/10/2016
    source release, such as the Canon Powershot SX60 (newly available in August, 2014).  Because
    dcraw could conflict with the standard TIFF format, you have to use Probe Order to enable CR2 
    and you have to make sure ffmpeg does not probe it first!!
7. Added new Probe Order preference under Settings→Preferences→Performance which can be seen
    in that window under the Performance tab.  Default action is that the “probe order” will be the same
    as it has been and only users with very specific requirements – such as “raw camera” - will want to
    change the order.  See Features5.pdf for usage.  (Report of generic bug via Lucas Rachunek).
8. Moved Tips of the Day to a file for easy editing by anyone.  Msg.txt updated to highlight the more
    relevant recent release note items in Setting→Preferences→About.
9.  Zoom capability in the compositor window feature allows for zooming in at any level via slider for
     the magnifying glass, adjust camera and adjust projector – shows on the left of screen below icons.
10. Bugs/Issues fixed:
    Circular buffer for audio now being flushed when less than a whole frame (Kent Dorfman reported).
    Graphical Equalizer plugin lock problem of reading at the same time as being deleted, is now fixed.
       (Andrew Randrianasulu reported).
    Plugins piano, synthesizer, bezier histogram, and compressor plugins potentially had the same bug
       as the equalizer plugins so problem eliminated there too  (discovered while fixing Equalizer).
    Using the Delete option while doing a drag-edit, or several other functions (about 32 total), was
       SEGV-ing so a fix was put in to suppress operations of keyboard accelerators at that time.
    Gif type files were not being correctly handled by ffmpeg, but that is now fixed.
    Discovered bug with unintialized variables and a serious Lock issue while working with CR2 (raw
        image files) produced by several cameras.  Ffmpeg does not handle these types, but dcraw does.
    Replaced the “textbox position array” that was not always correct, with the “current instance
       position”.
    Quit command keyin while running playback is now being handled so no longer segv’s.
    Reworked filelist.  /  Versioninfo updated.
    Fixed SEGV bug in mjpeg caused by undefined rows.
    Plugin client code bug found (used for skipping ffmpeg plugins that do not work).
    Weird bug in rgb601 found via code inspection has now been repaired.
    Title plugin mask-width and text-width problem for long lines followed by short ones is fixed.
    Moved “build ffmpeg marker indexes” from Settings→Preferences from Performance to Interface.
    Minor correction referring to Language (language, region, encoding).
11. Latest version, 375.66, Nvidia driver is working correctly with 5.1 OpenGL (tested on Fedora).

5.1  Release Notes for changes from 04/01/2017 to 04/29/2017 for these builds

1. 14 Third-party libraries have been upgraded to latest, which includes ffmpeg version 3.3 and
    x264/x265 version 2.4.  These upgrades are done to keep up to date and relevant with the world.
2. Upgrade to interface ffmpeg level 3 – this is a big change to the code and even though it was tested
    as well as possible, if you encounter any rendering operations that are not quite right, please report.
3. Blue Banana plugin improvements (originated from Monty, tested by Igor) & fixups include:
    “End Mask” is now operational with the addition of the Alpha output channel.
    A new operator, Combine Selection, provides 2 selection modification modes – intersection,
        referring to “inclusion” (unchecked), and union referring to “combine” (checked).
    Size of thread local storage has been doubled to accommodate computers with more memory.



    Commit configuration change was made because the program was on a timer instead of committing
       only if there was an actual commit pending.
    Alpha slider graphical line, which had been previously added to allow for changing the alpha value
       when using a color model that includes alpha, has been fixed with respect to Alpha channel.
4. Added Shift-G as a hotkey for Background Rendering as a toggle on/off (AVLinux/Glen request).
5. Option file for ogg now available with ffmpeg using libtheora for video and libvorbis for audio.
6. Operational change for 1st time users or no existing bcast5 – ffmpeg probes early is now default.
7. In Resources window, the Info pulldown->Details now shows the media file format.
8. A build for ubuntu 17 was tested and has been included this month (instead of ubuntu 15).
9. Bugs/Issues fixed:
    Background Rendering was not working as discovered through testing by Glen and is now fixed.
    Alignment issue when zooming in video/audio has been reworked after problem pointed out by Glen
       and a fix was put in.  This is ONLY when using ffmpeg.
    In the Titler, the font selection highlight has been changed to cover space of the 2 demo characters.
    If have multiple Viewers up and you drop media onto one, it would only drop on the 1st one.  Now
       that is fixed along with other minor issues when have more than one Viewer.
    Fixed problem that showed up in Info on media in Resources window where “resize track” had been
      changed but not saved.
    Noticed when using mpeg as opposed to ffmpeg, that if the Format settings weren't matching
       between the session file and the Index for the asset, the asset would get clobbered.  Now if Format
       does not match, then a rebuild index will be performed.  Other asset related corrections went in.
    Several plugins, which used the colorpicker, when detached from the track would inadvertently leave
       the colorpicker window up so that has been fixed (for example, Chroma key).
    A SEGV has been fixed when no hrs./mins./secs. were supplied in some cases.
    In any of the Render windows, the “View” after clicking on the Video/Audio wrench, will be
      automatically preloaded with the current option values.
    Replacements became available for faac and faad libraries so were deleted.
(The next 3 issues were found/fixed thanks to testing/information provided by “James Kool”.)
   Aspect Ratio when not 1 to 1 in scaling, has been fixed by correcting the position of the numerator
       and denominator.
   Seek on media that has no/or hardly any key frames had a problem leading to gray-colored output.  
      This has been addressed by adding keyint/min_keyint in the options files for h264/h265.
   When the Settings→Format width and height are modified for the session, the track sizes will be set
       to at least the output size whenever the format is updated.  Also, all edits on the track will be set to
       the largest format if smaller.
10. Open Problem:   
      Nvidia driver, version 378.09 has broken Opengl but the older version 375.39 works. 

5.1  Release Notes for changes from 03/01/2017 to 03/31/2017 for these builds

1. Title plugin improvements/fixups to include color picker history/picking/showing, font picker.
    Color Picker Changes  :  
     Now there are a set of 16 last used colors saved so you can choose them more easily.
     The hex value of the color shows up in a textbox and you can key one in, followed by Enter.
     You can select a specific color you want from the screen as a choice by using the eyedropper – move
        the reticle cursor around the screen to find the desired color.
    Tool Tips were added for these also.
    Font Changes  :  



    Added environment variable, BC_FONT_PATH, to make it easier to include more fonts (see pdf
       file for usage).  Also, included a “fixed” font that can be the default and can keyin to font box.
    Changed usage from fonts.dir to fonts.scale and ttmkfdir to mkfontscale to fix bugs and eliminate
       duplicates.
    Find font faster now working correctly via keying in beginning characters; it is case sensitive.
    Changed size of the font box to show more characters in the name.  Also, box not as long.
    Code now compensates for less-than-ideal font files that contain a blank in the name and glyph
        x-escapement that is either negative or way too big.
    Stroker, for “pen strokes” inside characters, is a new choice.  This had been commented out, but now
        has been slightly modified.  This code originated from Akirad/Andraz Tori and they get full
        credit for many very nice features now included in this branch.  
    With non-perfect results, the Bold and Italic checkboxes will be ghosted out if not available for font.
2. A build for 32-bit Debian is now included as an additional standard build.
3. The Russian ru.po file has been meticulously updated by Igor Ubuntu and is much appreciated!
4. Because there can be ambiguous translations for an english word/abbreviation, a methodology
    has been developed to differentiate within a program routine via C_ and D_ instead of just _ .
5. When switching languages, the plugins did not always get new translations, but now should.
6. The tooltip policy of only showing once within a sub-window has been changed to show every time.
7. Additional Quicktime options files for v308 and v410, plus 16mmto264 are now available
8. Bugs/Issues fixed:
    If you delete a Track in the main window with the title plugin up, it no longer crashes.
    A leftover thread causing problems if click on certain menu item, if already up, has been fixed.
    Fade/curve not copying correctly in the backward direction (to the left) is now working right.
    Titler plugin has been changed to add some number to prevent roundoff error.  This bug exists in
       every plugin that uses interpolation and will eventually have to be fixed.
    Focus policy checks in preferences was not staying in effect from session to session.  Now does.
    A bug in the Title plugin font selection which led to incorrect fonts being selected has been fixed.
    Re-fixed the 2/28 release incorrect code for the Resource Window asset edit.  
    Update vicons modified to correct errors.
    Resize Tracks was SEGV-ing under unusual circumstances so that was fixed.
    Menu popup was missing a delete and this caused problems but is now working correctly.
    The Attach Effect printed out extraneous error messages when left up between sessions.
    

5.1  Release Notes for changes from 02/01/2017 to 02/28/2017 for these builds

1. Title plugin new features have been added – Drag with 9 different handles, Background video,
    individual character attributes of Color, Size, Font, Underline, Bold, Italic, Caps, Blink, Alpha,
    Nudge, Sup(erscript,subscript), and PNG inclusion.  Right click in textbox to see options.
2. In Settings→Preferences->Interface there are 2 new buttons “Click to activate text focus” and
   “Click to deactivate text focus”.  These are handy for distros which may not have focus policies.
3. The color picker has been enhanced to include YUV – you will see this in Titler and Keyframes.
4. Bluray creation changes include accommodation for non-root “loop udfs” mounts & umounts
    with /etc/fstab change and added 2 additional options files to handle DV/AVC 720 Pal/Ntsc.
5. Bugs/Issues fixed:
    The tab “Sample zoom” disappearing after re-sizing the main window is now fixed.
    Refresh widget and highlighting had minor issues that were hardly ever noticed, but now fixed.
    Bitrate for BD Create menu was being ignored due to muxrate parameter and now corrected.



    To avoid minor error message of “No such file or directory” related to theme png file non-existence,
         a place holder png has been added.  Code is being retained in case the need for common shared
         icon data becomes desirable in the future.
    Batch/BD/DVD Render popups which contain “Warn if jobs mismatched” now re-sizes correctly.
    A Lock bug caused a SEGV when a lot of plugins were added to the canvas track, so fixed.
    Quality parameter for h265 is non-functional in ffmpeg, so to avoid confusion, no longer visible plus 
         the default will be -1 instead of 0 because 0 is a legal value for Quality in h264.
    Most of the Motion plugins have had a code line moved up to ensure edge case does not crash.
    AgingTV plugin crashed because had no associated “presets”.  Added dummy ones.
    Align edit for audio tracks was not being correctly aligned in some cases, but now is fixed.
    The “Load Jobs” in batch-type renders was not always refreshing so fixed that.
    Motion51 has had the drawn vector lines modified so that they seem to disappear/change less.
    Resource window asset filename change had a bug in it that the change was not taking effect.
    The “show” control on the plugins is now coming up immediately without having to click twice.
    A “window event” in a stale window led to some hard-to-find erratic behavior – now fixed.
    Looping bad LADSPA_PATH setting has been changed to go on instead.
    
 
5.1  Release Notes for changes from 01/01/2017 to 01/31/2017 for these builds

1. Textbox now allows for insertion of non-standard characters, such as accent grave or any
    unicode character.  This change will come in handy for the Title plugin textbox so you can
    add a bullet more easily, or to change a Track name to contain an umlat character (W P Titler email).
2. Motion51 added which is a different method for motion stabilization that might be easier to use and
    understand and may be faster to run.  The usage and parameters are documented in Features5.pdf.
3. Smooth Lines program code included which can be used to create near-perfect circles and curves.
4. Alpha modification graphical line added to Blue Banana to allow for changing the alpha value
    when using color model in “Set Format” that includes alpha; for example, RGBA or YUVA.
5. Bluray creation changes incorporated to include (Terje reported):
    Numerous changes to bdwrite, bdcreate.C, and ffmpeg to get another bluray player working.
    1440X1080,... output formats were switched from 4:3 to 16:9 as a result of standards shown online.
    Default bitrate for video switched from 8 Mbps to 10 Mbps based on standards and experience.
    Audio default bitrate set at 192K to match best standards and most frequent usage value.
    Cin_bitrate, cin_quality parameters added for lossless.opts file to affect the default values.
    Visually_lossless options file added which generates bluray media that is close to what you can see.
    Presentation graphics-type subtitles can be written via bdwrite (but cinelerra does not have yet).
6. A change in Interlace mode rendering needed for bluray may side-affect other rendering.
7. Bugs/Issues fixed:
    Batch Render mismatched Path in edl due to full versus relative path name fixed (Igor reported and
       sent session files leading to a fix with W P confirmation of bug).
    New Project window was being cut off so tweaked mods provided by Igor to fix this in all of the
       various themes (W P reported and Igor provided fixes).
    Title plugin error when scrolling with wheel in the fonts (W P reported in email).
    Dropped mod that affected Quality while rendering with libx264 due to junk parameters has been
       fixed.  Bitrate was still working just fine so mod got missed (Glen email and Igor confirmed).
    For mp4 File Format rendering, the h265 Quality parameter does not exist due to an ffmpeg
        restriction.  In order to provide equivalent options without affecting h264, added 4 new
       option files - h265.mp4, hi, lo, medium.  Bitrate works the same as h264 though.



    Options in the Video Preset “edit box” non-existence due to erasure no longer cause problems.
    OpenGL affine bug fix caused by incorrect usage of pbuffer instead of pbuffer_bit.
    EchoCancel plugin bug that also affected Motion51 located and fixed.
    Raw DV codec missing audio component so was added.
    Missing cursor and location issue in textbox has been fixed (reported by W P in Title plugin).
    Additional focus/cursor textbox modifications made to fix problem found in testing Batch Render.
    New Project missing edl caused a crash on edge case (Phyllis discovered while testing).
    Moved Render and New under file pulldown to not block edge of window (reported by W P).
    Some more Russian translations added in (Igor provided).
    Audio waveform getting cut off when big increases in the height of track in the timeline is fixed.
    For ffmpeg, rgb8/rgb16 intermediate frame buffer were used to transmit non-conforming
      colormodels. This caused problems with the colorspaces (bt601/bt709) and was replaced with
      yuv16 when the src and dst frames are both yuv.

5.1  Release Notes for changes from 12/01/2016 to 12/31/2016 for these builds

1. Distros updated on personal local computer which is used to build these Cinelerra-GG binaries –
    latest version of Leap/Mint/Centos/Arch/Debian/Fedora with only latest updates on others.  
    Previous versions of newly installed Distros will no longer have new builds.  It is impossible to
    maintain them all, but requests for specifics will be considered.
2. Build scripts changes to streamline builds and encompass necessary inclusions for different O/S's.
3. Lossless rendering has been added as an option for h264/yuv420p input media.  This produces files
    that are HUGE and may be more than 10 times bigger, so must be used with great caution.  Part of
    this change should result in more direct transcode, without further manipulation by ffmpeg which it
    might have been doing due to incomplete knowledge of the input media.  This could produce better
    results in some cases.
4. New profiles provided to include “lossless” for m2ts and “ks.pro” for ProRes.  The existing ProRes 
    is Anatoliy's, but ks.pro is Kostya's and supports more profiles to include 444 encoding.
5. Change ffmpeg buffer strategy because it was not completely working and handling all parameters.
6. Changes for BD Render bluray creation to include (Terje suggestions / improvements):
    Four more choices in Create BD window for 1440x1080 HDV format used by digital camcorders.
    Submenus added for the possible format choices because there are now 17 possibilities.
    Decision on which bluray format to use automatically comes up based on the user's input.
    Timezone used to make the default setting if format unknown  – 1920/29.97i US or 1920/25i EU.
    Batch job save capability feature added to facilitate re-running a job and to be able to make changes.
    The setting for “Work path” is now saved across sessions.  Also applicable to DVD creation.
    Changed the default “Configure Video Compression in use, “Bluray.mts”,  profile to high.  
    Added another Video Compression choice of bluray-lo with profile of baseline to replace original.
    Lossless choice added but bluray media generated incomprehensible on TV bluray player.
    Interlacing added to bdwrite to work correctly – previously all being processed as Progressive.
    Non-standard bluray format choices, along with a warning, added as Progressive since worked.
    Ability to change the Title in Create BD for entire directory name instead of using bd_datetime.
    Warning message added for BD because need to be root for udfs file structure so can loop mount.
7. Additional Russian translations provided by Igor were incorporated with 2143 total translations in.
8. Added minor feature in File→Load files to load only .mp4 or only .mkv and deleted the options
    for .heroine and .vob,.ifo since little, if ever, used. (W P email suggestion on mp4/mkv).  
9. Sort in File→Load files… improperly preserving previous field sort has been fixed.  By clicking a
    filebox column header, you change the sort selection.  When the contents is sorted and 2 key fields



    match, the original order is preserved.  This means if you first sort on size and then on extension,
    you will see all the files sorted by extension and within each extension it will be sorted by size. 
    Previously it would just sort the one field.
10.Bugs/Issues fixed:  
    Transfer Geometry for YUV had the Y offset shifted under certain circumstances.
    Improved ffmpeg filter parameters in the opts file so that all of the various parameters are handled.
    Incorrect ffmpeg parameters in the opts file would lead to a crash, but now will return error instead.
       (Above 3 issues discovered as a result of investigating luma range confusion/user complaint).
   Track/Title names/tags being ignored – mistake of deleted line put back (reported in Chris email).
   New Project Dialog box has been added back (Terje reported / Igor comment of choice preference).
   Vflip ffmpeg plugin fixed (reported in Sam email as a SEGV).  Also, fixed F_ciescope/F_datascope.
   Locking BC_Trace serious problem exhibited at least when deleting the Recording window on a
       laptop (Phyllis reported SEGV).
   Recording use of Remote Control problem causing user to have to physically shutdown computer
       (Inconvenient error discovered by GG). 
   A lot of .mts files were mistakenly being treated as mpeg instead of x264 so video or audio would not
       load.  Deleted code allowing this so ffmpeg can load correctly (Ed email and Igor reaffirmation).
   Race condition if rendering a frame at exact same time as executing Close in at least 1 place fixed.
   If render to mkv, if invalid parameters are passed to ffmpeg, it no longer crashes (W P reported).
   Color model names better defined for use in the debugger (Programmer helpful information).
   Patch in x.264 applied to remove booby trap that should no longer be necessary.
   
5.1  Release Notes for changes from 11/01/2016 to 11/30/2016 for these builds

1. Merged in HV6 improvements from that annual update by the original author.  This covers:
    Background Rendering now has the capability of providing an “end” point and a “range” besides the
        already available “begin” point.  It was pointed out that this was a needed and nice addition.
    Reframe plugin, for audio and video. differences added to change from Scale to Input/Output. 
    Good speedup in Motion Stabilization plugin added as Motion_HV.  Name change due to deletion of
        features that some users still want such as “Track translation”, “Add (loaded) offset from track”,
        and Translation/Rotation “block size” adjustments. 
    Added some small stuff, for example print statements, that don't affect what the user sees.
    Not added - subtitle plugin changes because already had alternative and it proved to be unstable.
        The requirement of providing time in format of 01.05.06.388 is tedious in version 6.??
    Not added - other HV6 changes that were already available in this version, such as updates of
        ffmpeg, h264, and overlay frame changes.  Quicktime changes not added because 5.1 uses ffmpeg.
        Also, did not delete the picons in the Resources window or include deletions done in awindowgui.
2. Performance enhancement gained through a rewrite of tracking locks – most noticeable in large
        media files when using motion stabilization; however improves performance just about 
        everywhere.  Code change: Trace data was moved out of Signals file into Trace file and Thread
        data was moved out of Thread Tracing into Trace file.
3. Webm, Xvid, flv, and f4v Codecs/Formats added as requested (some of the more popular ones).
4. MotionCV has been added as an alternative for Motion Stabilization plugin with minor changes:
        Fixed “Track translation” bug; cleaned up code constructs;
        Changed output which has been multiple/1,000s of files on /tmp to single file of the user's choice;
        Warning added if Settings→Preferences→Playback A, Video out NOT set to “play every frame”;
        If not playing every frame, when it has to recalculate, it will save the new data in Tracking file;
        Initial values increased to gain good output but will take more clock time so may want to adjust;



        Window size and positioning changed to accommodate language translations.
        Default Calculation set to “Save coords to tracking file” and changed its option list order.
5. Project SMP cpus count added to Settings→Preferences->Performance which gives the user the
        ability to restrict the number of cpus utilized in the plugins for higher cpu-count computers. 
6. Bugs/Issues fixed:
    Subtitles were being dropped if a frame got missed so fixed this.
    Minor fix to OGG program code discovered by web sample .ogv file.
    Plugindb bug fixed which caused a SEGV crash in Render Farm.
    Order in the asset pulldown/Resources window was changed to make "info" show up as 1st choice. 
    Removed extra blank character in the code for plugins that was leftover from the “old days”. 
    Code changed to allow user to add ffmpeg and ladspa picons; before could only add standard icons.
    Window size and positioning for Motion (5.1 version) and MotionHV increased for translations.
    

5.1  Release Notes for changes from 10/02/2016 to 10/30/2016 for these builds

1.  Ffmpeg upgraded to 3.1.4 vendor version.
2.  X265 upgraded to 2.1 vendor version.
3.  More strings made into symbolic names modification from Einar branch was added, with minor
     changes.  This was a excellent idea with full credit to Einar so more words can become translatable.
4.  Cin.po and other languages po files updated with almost 300 new strings and 3 deleted strings.
     More Russian applied as provided by Igor and it is now looking nicely correct and almost complete.
5.  OGG handling updated to handle additional legitimate formats such as those files without the usual
    expected keyframes for seeking.  (Note, technically “recordmydesktop” does create legal ogg files.)
6.  Bugs/Issues fixed as reported by several users, Igor, and programmer-discovered:
     Minor mods to Overlay /Alpha BlendingModes as needed.
     Widen a couple of windows to make room for language translations.
     Video4Linux2 replaced Video4Linux awhile back, so removed V4L along with old drivers Buz/Lml.
     YUYV color model errors corrected.
     Tip of the Day previous tip was not working so fixed that.
     Echo plugin offset=0 is an illegal choice because divide by 0, so eliminated that.
     Quit from Cinelerra slightly reworked because sometimes not quitting some windows.
     Fixed empty folder showing up in Resources window because of XML name conflict.
     Roundoff was added in thousandth position for the zoombar values, but may need further tweaking.
     Editing refresh for partial frames modified if edit width > 1.5% of the pixels of the timeline.
     MPEG packet buffering rework to alleviate TOC problems.
     Fixes for XFT text rendering when gc function is not copy.
     
5.1  Release Notes for changes from 09/01/2016 to 10/01/2016 for these builds

1. Button operation choice added of “Popups activate on button up” (default) or “Popups               
activate on button down” via Settings→Preferences→Interface Flags checkbox.
2. SVG via Inkscape plugin has had numerous problems fixed.
3. Scroll bars and picture location in the Compositor window were incorrect and have been fixed.
4. Color-coded keyframe curves and operational details with “Color Balls” enhancements (see
    Window→Show Overlays) allowing for personal preference setup on colors (Igor's 2015 email).
5. Overlay Modes/alpha blending/PorterDuff addition of 8 new blending variations.  Also, overlay
    mode popup menu converted to submenu setup as changes to current popup no longer fit.  To see,



    click on the right arrow in track's patchbay which expands to show a down arrow to click on with 
    tool tip “Overlay modes”.
6. Features5.pdf manual updated as part of the installed software base.  Left click on the little yellow
    box (>_._) in upper right hand corner of main window to bring it up.
7. Bugs/Issues fixed:
    Fix resize window jitters and Xv minor rewrite fixes particularly noticeable in the zoombar.
    Bug fix for “frame size” specification not divisible by 4 in a single case.
    Labels not being correctly asynchronously updated has been fixed.
    Vwindow code fix that affected Resource media being dragged to timeline when no Viewer window.
    Fixed overlay YUV problem introduced on a rework from Monty's original code addition.
    Put back dropped build parts such as large file support fix for 32-bit (as discovered by Andrew).
    Improved dump capture to make debugging user problems more descriptive.
    Masking interpolation was being handled incorrectly for mode and now is correct.
    Keyframe alignment fixed – align cursor to frame side setting affects auto keyframe creation.  Fixed 
        bug where unaligned keyframe is selection target, but new aligned keyframe created instead.
    The Settings pulldown menu resizing operation left some buttons cut off and is now better.
    Russian translation has had some more key translated phrases added by Igor_Ubuntu.
    Compiler warning cleanups for various distros (all distros were upgraded prior to builds).
    Some submenus were not working properly for popup submenu items and has now been fixed.
8. SVGs for all of the background themes has been lengthened from 750 to 880 with credit to Igor
    for all of that tedious work). 
 

5.1  Release Notes for changes from 08/01/2016 to 08/31/2016 for these builds

1. TDB – Traveling Data Base additional features to include add escalate keys and entity alloc cache.
2. Ffmpeg 3.1.2 update from 3.1 vendor version.
3. X265 upgraded to 2.0, includes multiprocessor bug fix (no longer have to carry my mod).
4. Issues/bugs as reported by Igor_Ubuntu in the past month below:
   Bug fix forTab or Shift-Tab not working at all while cursor is over a track to toggle arming status.
   Goto image set not found in Bright Theme was fixed.
   Reverse Edits and Shuffle Edits fix for the case of the selection at the beginning.
   Multi-pane mode fixes to update the Y or X newly split pane correctly.
   Multi-pane mode bottom left pane drag bar was shadowed by the canvas so now fixed.
   Fix selection length when double-click left mouse & insertion strategy is replace project /concatenate.
   Right click on Track Canvas behavior change to avoid unintentional activation of Attach Effect.
5. Correction for Mute attribute patchbay inconsistency with other attributes using click-shift.
6. Italian translation updated for only some phrases (“borrowed” from CVO updates!).
7. Arch Linux build change to accommodate cflags+ instead of cflags.
8. Additional plugin, yuv411, that performs interpolation and inpainting for DV source improved 
chroma upsampling results (courtesy Eric Olson website as pointed out by Igor_Ubuntu).  It also has an 
additional setting called offset which shifts the chroma planes to the right by one or two pixels (set to 0 
for DV source downloaded from a camcorder and set to 1 for a DV file encoded by ffmpeg).  Works 
with the YUV-8 Bit or YUVA-8 Bit color models in Cinelerra but not with any of the RGB color 
models.  Improved upsampling of the chroma planes helps with the 4:1:1 to 4:2:0 color space 
conversion needed to create DVD compliant mpeg2 video streams.  You will not get any improvements 
if the project is being rendered back to DV format.



5.1  Release Notes for changes from 07/01/2016 to 07/30/2016 for these builds

1. Russian translation from Igor_Ubuntu in ru.po with complete and correct verbage.
2. SEGV fixes – Arm first track in patchbay; Quit with render menu active.
3. Chroma bug yuv420p interlace colormodel fix for DVDs via additional option “dvd yuv420.”
4. Upgrade ffmpeg from 3.0 to 3.1.1.
5. Ffmpeg fixes - index marker fix; add ffmpeg image 2 formats for 48bit TIFF.
6. Remove faac libmp4v2 from build since it is no longer necessary and was causing build errors.
7. Layout changes and improvements to accommodate longer word translations for other languages.
8. Filescene for simple animation fixes.
9. Subtitle upgrades for filename requirement and add some error messages.
10. Textbox fixes/upgrades – certain highlighting/pasting length problems.
11. Xlat changes – loadmode, add nodups and dups options, change csv to list, string.
12. Add config.rpath to ladspa for build to avoid errors.
13. Add djbfft - extremely fast library for floating-point convolution on general-purpose computers.. 
14. Miscellaneous fixes; Quit deadlock fix; avoid overloaded casting pun from tripping the compiler; 
“friend class” change.

5.1  Release Notes for changes from 06/06/2016 to 06/30/2016 for these builds

1.  DVD/BD creation rework – incorporated user feedback changes such as eliminating non-legit 
DVD type choices; dialed in correct set of choices for BD (blu-ray); added ScaleRatio plugin for major 
assistance in scaling/cropping/filled/edges; renamed and added in new 10 bit and hevc formats; put in 
warning message for “changed” EDL.
2.  Added packaging for several distros and minor changes as discovered.
3.  Fixed unlock that created issues for certain Intel chips using TSX - Transactional Synchronization 
Extensions – this bug was in code carried over from original HV with the 4.6.1 mods.
4. Set up “booby trap” to print out message if an attempt to unlock an item that is already unlocked.
5. Changed popup menu behavior so that right click on viewer/compositor windows does not goto 
fullscreen automatically and lead to what looks like “black screen of death” (refer to email problem 
reported “A strange display behavior” on June 11th by Terje Hanssen.  This change was not specific to 
this strange behavior so will affect other windows as well.
6. Arch Linux addition required changes for configure params, different specific compiler issues, and 
some new compiler warnings were generated so had to be fixed.  Refer to email “Cinelerra 5.1 Arch 
Linux Binaries?” from Gatitofelix on June 18th.

7. A few “make” file improvements related to autoconf autogen/automake not affecting cinelerra 
code.  One of these change resulted from the email of June 16th  “Cinelerra 5.1 packages and 
repositories” from Lukas Rachunek.
8. Resize fix for when redraw a certain window.
9. Add more colorspace between ffmpeg and cinelerra.
10. Cut and paste to handle double characters such as accent grave and umlats repaired.  This fix was 
a result of the multiple emails by Peter Turner and the responses in the June 25th-30th time frame.
11. Fixed a SEGV that occurred when a “Gui” was not actually in a list box window.  Discovered this 
when it was popped during a “prt sc” (print screen) key press resulted in a SEGV crash.
12. Info crash button fix June25th email from Igor “CVO - Crash - Asset_Info – Interlace”.  This fix is 
a non-specific fix and will generically fix any of these type errors that may be encountered elsewhere.
13. Tan_smooth and Tan_linear added in Blue Dot theme.  Refer to Igor email dated June 25th “Add 
missing images to Blue Dot theme”.



14. If you hold down zoom and zoom in super-fast, it starts redrawing but when it zooms in as far as it 
goes, there is a deadlock in the mwindow.  Fixed this bug.
15. Bug in clipboard due to defective logic discovered by code inspection.  Very unlikely a user would 
experience this bug where the buffer size is wrong and stuff is skipped over.
16. Mask rendering was a little broken so fixed this – some previous change side affected masking so 
was not working quite right.
17. Nested edits SEGV'ed when tried to insert pasted edit under certain conditions.


